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Safety precautions
Before using your equipment, read the following safety precautions to make sure you use the equipment 
safely. Do not carry out any operations or procedures other than as described in this document, because 
doing so may result in death, serious personal injuries, or fire.

CAUTION: Handling the equipment always requires two people. Care must be taken to avoid back strain 
and/or injury. Use of personal protective equipment is recommended.

Mains connection
● Use the power supply voltage specified on the label. Avoid overloading the equipment's electrical outlet 

with multiple devices. Doing so can cause a fire or an electric shock hazard.

● Use only the electrical cord supplied by HP with the equipment. Do not damage, cut or repair the power 
cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-
approved power cord.

● Do not set heavy objects on the power cord; do not bend the cables or force them into contorted 
positions.

● Insert the power cord securely and completely into the wall socket and equipment inlet. A poor 
connection can cause a fire or an electric shock hazard.

● Do not handle the power cord with wet hands. Doing so may cause electric shock hazard.

● Observe all warnings and instructions marked on the equipment.

Equipment operation
● Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the 

equipment. Doing so may cause fire, electric shock or other serious hazards.

● Do not insert your hand into the equipment while it is printing. Moving parts inside the equipment may 
cause injuries.

● Keep your clothing and all parts of your body away from the equipment's moving parts.

● Avoid wearing necklaces, bracelets and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the equipment.

● Ventilation measures, for your location either “office” or “copy, printer rooms” should meet with local 
environmental health and safety (EHS) guidelines and regulations.

● Unplug the equipment from the wall before cleaning.

Equipment servicing
● There are no operator-serviceable parts inside the equipment except those covered by HP’s Customer 

Self Repair program: see http://www.hp.com/go/selfrepair/. Refer servicing of other parts to qualified 
service personnel.

● Do not disassemble or repair the equipment yourself. There are hazardous voltages inside the 
equipment that can cause a fire or electric shock hazard.
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Caution
Turn off the equipment and unplug the power cord from the power outlet in any of the following cases:

● If there is smoke or an unusual smell coming from the equipment.

● If the equipment is making an unusual noise not heard during normal operation.

● If a piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of 
the equipment.

● There is any mechanical or enclosure damage.

● During a thunderstorm.

● During a power failure.

● The power cord or plug is damaged.

● The equipment has been dropped.

● The equipment is not operating normally.

HP Start-Up Kit
The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and 
documentation.

Using this guide
The User’s Guide can be downloaded from:

http://www.hp.com/go/T730/manuals

http://www.hp.com/go/T830/manuals

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.

● Connecting the printer on page 17

● Setting up the printer on page 23

● Personalizing the printer on page 29

● Paper handling on page 35

● Printing on page 47

● Mobile Printing and Web Services on page 12

● Practical printing examples on page 83
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● Handling ink cartridges and printhead on page 101

● Maintaining the printer on page 105

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

● Troubleshooting paper issues on page 123

● Troubleshooting print-quality issues on page 141

● Troubleshooting ink cartridge and printhead issues on page 181

● Troubleshooting data communication issues on page 185

● Troubleshooting general printer issues on page 193

● Front-panel error messages on page 197

Accessories, support and specifications
These chapters, Accessories on page 119, HP Customer Care on page 199 and Printer specifications 
on page 203, contain reference information, including customer care, the printer specifications and part 
numbers for paper types, ink supplies and accessories.

Glossary
The Glossary on page 209 contains definitions of printing and HP terms used in this documentation.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the 
printer from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury 
or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or 
damage to the printer.

Printer models
This guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name

HP DesignJet T730 Printer T730

HP DesignJet T830 Multifunction Printer T830
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The printer’s main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 914 mm (36 in). 
If your printer is a T830 Multifunction Printer, it also has an integrated color scanner capable of scanning 
images up to 914 mm (36 in) wide. Some major features of the equipment are shown below:

● Print resolution of up to 2400 × 1200 dpi using the Best print-quality option, the Maximum Detail 
option and photo paper

● Scan resolution of up to 600 dpi, in RGB color with 24 bits per pixel, or grayscale with 8 bits per pixel, or 
black and white with 1 bit per pixel

● The printer can be controlled from its front panel or from a remote computer using the Embedded Web 
Server or the HP Utility

NOTE: Throughout this manual, “HP Utility” refers to the HP Utility for Mac OS X and the HP Designjet 
Utility for Windows.

● Touch-sensitive front panel in color, with an intuitive graphical user interface

● Supports Ethernet or Wi-Fi connection

● Hi-Speed USB host port for connecting a USB flash drive

● Mobile Printing and scanning includes Web-connected features such as automatic firmware upgrades 
and HP ePrint

● Handles roll and cut-sheet paper, with a multi-sheet tray

● Color emulations, see Printer emulation on page 55

● Economode for printing economically

● Ink and paper usage information available from the Embedded Web Server, see Access the Embedded 
Web Server on page 30

● Supplies information, troubleshooting, and firmware updates available from the HP Utility, see Access 
the HP Utility on page 30

● Access to the online HP Support Center (see HP Support Center on page 200)
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The printer’s main components
HP DesignJet T830 Multifunction printer front view

1. Multi-sheet tray extenders

2. Ink cartridges

3. Ink cartridge cover

4. Printhead door

5. Printhead

6. Output tray extenders

7. Bin

8. Output platen

9. Front panel

10. Scanner cover

11. Front window
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HP DesignJet T730 Printer front view

1. Multi-sheet tray extenders

2. Ink cartridges

3. Ink cartridge cover

4. Printhead door

5. Printhead

6. Output tray extenders

7. Bin

8. Output platen

9. Front panel

10. Scanner cover
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HP DesignJet T830 Multifunction printer rear view

1. Roll cover

2. Communication ports

3. Multi-sheet tray
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HP DesignJet T730 Printer rear view

1. Roll cover

2. Communication ports

3. Multi-sheet tray
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Communication

● Ethernet port

The front panel
The front panel is a touch-sensitive screen with a graphical user interface; it is located on the front left of the 
printer. It gives you complete control of your printer: from the front panel, you can print, view information 
about the printer, change printer settings, perform calibrations and tests, and so on. The front panel also 
displays alerts (warning and error messages) when needed.

The front panel has a large central area to display dynamic information and icons. At the top of the central 
area there is a dashboard that displays the Home screen icons. To interact with these icons swipe down the 
dashboard status to access the Dashboard.

On the left and right sides of the screen you can see up to four fixed icons at different times. Normally they 
are not all displayed at the same time.
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Close to the front panel is the Power key  , with which you can turn the printer on or off. The key is 
illuminated when the printer is on. It flashes when the printer is in transition between on and off and when 
the printer is in sleep mode.

Left and right fixed icons

●  shows the status of the wireless connection: if the blue light is on, the wireless connection is active.

● Touch  to return to the home screen.

● Touch  to view help about the current screen.

● Touch  to go back to the previous screen without discarding changes.

Home screen dynamic icons

The following items are displayed only on the home screen.

● In the central area of the front panel are the paper tab icons.

◦ Touch  to load, unload, and change options for roll paper.

◦ Touch  to change options for the multi-sheet tray, or to activate it.

◦ Touch  to load, unload, and change options for single sheets.

NOTE: The active paper source is indicated by a slightly larger icon, with a white tick in a blue circle: 
 .

The dashboard icons are located at the top of the central area.

● Touch  to change printer settings.

● Touch  to eject scanned original.

● Touch  to view ink information.

● Touch  to view information about printheads.

● Touch  to view connectivity status information and to perform network configuration. If a network 
cable is connected,  is displayed instead.

NOTE: It is not possible to use wireless and wired network connections simultaneously.

● Touch  to view information about wi-fi direct.

● Touch  to view information and configure ePrint to print from a computer or mobile device sending 
an email to the printer.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To 
change the time that elapses before sleep mode, Touch  , then Printer setup > Sleep Mode. You can set a 
time between 5 minutes and 3 hours.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external 
interaction with it.

Information about specific uses of the front panel can be found throughout this guide.
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Printer software
The following software is provided with your printer:

● The HP-GL/2 and HP RTL driver for Windows

● The Embedded Web Server allows you to:

◦ Manage the printer from a remote computer

◦ View the status of the ink cartridges, the printhead, and the paper

◦ Access the HP Support Center, see HP Support Center on page 200

◦ Update the printer's firmware, see Firmware update on page 113

◦ Perform alignments and troubleshooting

◦ Change various printer settings

◦ Manage email notifications

See Access the Embedded Web Server on page 30.

● The HP Utility allows you to:

◦ Manage the printer from a remote computer

◦ View the status of the ink cartridges, the printhead, and the paper

◦ Access the HP Support Center, see HP Support Center on page 200

◦ Update the printer's firmware, see Firmware update on page 113

◦ Launch the Embedded Web Server

See Access the HP Utility on page 30.

NOTE: New versions of all printer software can be expected to appear from time to time. In some cases, 
when you receive your printer there may already be later versions available on HP's website of some of the 
software provided with it.

Mobile Printing and Web Services
Mobile printing

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple 
steps wherever you are; using your mobile device OS or sending an email to your printer with PDF, TIFF and 
JPEG attachments.

● iOS-Apple printing is enabled through Airprint.

● For Android printing, install https://play.google.com/store/apps/details?
id=com.hp.android.printservice&hl=en the HP Print Service App from Google Play (in case you do not 
have it already pre-installed it in your mobile device).
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● You can also download mailto:https://itunes.apple.com/us/app/hp-all-in-one-printer-remote/
id469284907%3Fmt=8 HP All-in-One Remote for enhancing your printing capabilities and enabling 
Scanning and Sharing from the smartphone or tablet.

● To print by email go to HP ePrint, enable the service and retrieve the printer’s email address.

Enable email printing
1. Make sure that your printer is correctly connected to the Internet.

2. Enable Web Services during initial setup of the printer, or later by touching  on the home screen and 
following the instructions on the front panel. The printer may need to restart if it has updated its 
firmware.

3. This is an optional step: Activate your account by clicking the activation link that you will receive by 
email. If you don’t see the message, remember to check your junk email folder.

4. This is an optional step: If you are the printer administrator, log in at HP Connected 
(http://www.hpconnected.com) to customize your printer’s email address or manage printer security 
for remote printing.

Congratulations, you now have completed Web Services setup. HP ePrint is ready to use. For the latest 
information, support, and terms of use of the HP Connected see http://www.hpconnected.com. You can also 
benefit from automatic firmware updates after following this setup.

Turn the printer on and off
If you wish to turn the printer on or off, the normal and recommended method is to use the  next to the 
front panel.

However, if you plan to store the printer for a long period or the Power key does not seem to work, you are 
recommended to unplug the power cord.
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To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the 
printhead.

NOTE: When the printer has not been used for a certain period of time (the default time is determined by 
Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's front-panel 
display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To 
change the sleep mode time, see Change the sleep mode setting on page 31.
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Reports
The reports give various kinds of information about your printer. They can be requested from the front panel.

Before requesting any info prints, check that the printer and the paper are ready for printing. The loaded 
paper should be at least A4 portrait—210 mm (8.27 in) wide—otherwise the print may be clipped.

To print any report, swipe down the dashboard, touch  , then scroll down to Reports and touch it, then 
select the report you want. The following reports are available.

● Demo prints: show some of the capabilities of the printer

◦ Drawing demo

◦ Rendering demo

◦ GIS map demo

● User info prints

◦ Printer status report

◦ Print quality report

◦ Network Configuration Page
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2 Connecting the printer

● Choose which connection method to use

● Connect the printer to your network

● Connect a computer to the printer by network (Windows)

● Uninstall the printer software (Windows)

● Connect a computer to the printer by network (Mac OS X)

● Sharing the printer

● Uninstall the printer software (Mac OS X)
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Choose which connection method to use
The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Wireless Moderate; varies according to conditions 
(distance to router, interference, number 
of wireless clients, network topology, etc.)

N/A Sensitive to interference over longer 
distances; requires extra equipment 
(wireless access point or wireless router)

Gigabit ethernet Fast; varies according to network traffic Long: 100 m (328 
ft)

Requires specific equipment (switches)

NOTE: The speed of any network connection depends on all components used in the network, which can 
include network interface cards, routers, switches and cables. If any one of these components cannot 
operate at high speed, you will have a low-speed connection. The speed of your network connection can also 
be affected by the total amount of traffic from other devices on the network.

NOTE: Wireless connection can be affected by the location of the network router and the device. In order to 
improve the wireless connection:

1. Position the wireless access point in a more central position of the working place as shown in figure no 
2. Try place away from dense materials. Metal, concrete, double thick walls are the hardest to 
penetrate, wood and plasterboard are easier. Consider these when positioning the printer.

2. Change wireless channel to one that’s not being used preferably 1, 6 or 11 as these are non-overlapping 
channels.

3. Extend the range of the wireless network by using a simple wireless extender or adding more wireless 
access points as shown in figures 3 and 4.

Connect the printer to your network
The printer is able to configure itself automatically for most networks, in a similar way to any computer in 
the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front 
panel: touch  or  .

To connect to a wireless network, the easiest way is to go to the front panel, swipe down the dashboard, 
touch  , then scroll down the menu and touch Network setup > Wireless settings.

When a network device automatically configures itself by receiving an IP address from the DHCP service, this 
IP address may change from the last time the device is powered off to the next time it is powered on, which 
may lead to the device being shown as "offline" when driver port settings are configured with the original IP 
address. There are at least three possible ways to avoid this:
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● Increase the lease time of your DHCP server device.

● Set a fixed IP address for your printer that will not be changed by DHCP (see Communication failures 
between computer and printer on page 186).

● Configure the printer and driver to refer to the hostname instead of the numeric IP address (see 
Communication failures between computer and printer on page 186).

See the Assembly Instructions for more details about Internet setup, and how to connect to and register with 
the cloud to enable Web Services.

Connect a computer to the printer by network (Windows)
The following instructions apply if you intend to print from software applications using a printer driver. See 
Printing on page 47 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your 
network on page 18). The printer can be connected by Ethernet or Wi-Fi.

● The printer and the computer should be connected to the Internet.

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer's IP address from the front panel (see Access the Embedded Web Server 
on page 30).

2. Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the 
setup.exe program in the root folder of the DVD.

3. When the T830/T730 window appears on your screen, click Software and then Install.

4. Your Web browser opens to display the rest of the software installation procedure. You must select 
Windows or Mac OS X software, and choose which specific software you want to install (by default, all of 
it).If your computer fails to find any printers on the network, the Printer Not Found window is 
displayed, which helps you to try to find your printer. If you have a firewall in operation; you may have 
to disable it temporarily in order to find the printer. You also have the options of searching for the 
printer by its hostname, IP address, or MAC address.

In some cases, when the printer is not in the same sub-net as the computer, specifying the printer's IP 
address may be the only successful option.

Uninstall the printer software (Windows)
Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Connect a computer to the printer by network (Mac OS X)
You can connect your printer to a network under Mac OS X by using the following methods:
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● Bonjour

● TCP/IP

NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See 
Printing on page 47 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network. See Connect the printer to your 
network on page 18.

Now you can proceed to install the printer software and connect to your printer.

Bonjour connection
1. Go to the front panel and touch  or . Note the mDNS service name of your printer.

2. Insert the HP Start-up Kit DVD into your DVD drive.

3. Open the DVD icon on your desktop.

4. When the T730/T830 window appears on your screen, click Software and then Install.

5. Your Web browser opens to display the rest of the software installation procedure. You must select 
Windows or Mac OS X software, and choose which specific software you want to install (by default, all of 
it).

6. When the software has been installed, the HP Utility starts automatically, to set up a connection to your 
printer. Follow the instructions on your screen.

7. In the Setup Assistant screen, look for your printer's mDNS service name (which you noted in step 1) in 
the Printer Name column.

● If you find the right name, scroll sideways if necessary to see the Connection Type column, and 
check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down 
the list.

● If you cannot find your printer's name just click Continue and do the setup manually in your 
System Preferences later on.

Click Continue.

8. Continue following the instructions on the screen.

9. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.
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TCP/IP connection
1. Go to the front panel and make a note of the printer's URL (see Access the Embedded Web Server 

on page 30).

2. Insert the HP Start-up Kit DVD into your DVD drive.

3. Open the DVD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer.

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer drivers and other HP software, such as the HP 
Utility.

If you have enabled Web Services on your printer, you can print to your printer by email. Just check the 
Web Services menu for the email address of your printer, then send the file you want to print to that 
email address as an attachment.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a 
connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in the 
Printer Name column.

● If you find the right name, scroll sideways if necessary to see the Connection Type column, and 
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further 
down the list.

● If you cannot find your printer's name with an IP Printing connection type, check the box My 
printer is not in the list.

Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, 
click Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

Sharing the printer
If your computer is connected to a network, you can make your directly connected printer available to other 
computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. To enable printer sharing, go Sharing, select Printer Sharing, and then check the printer(s) that you 
want to share.

3. Your printer now automatically appears in the list of shared printers displayed by any other computer 
running Mac OS X and connected to your local network.

Please bear in mind the following considerations.
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● Any other users wishing to share your printer must install the printer software on their own computers.

● Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to 
receive information from the printer—which affects alerts, status reports, paper management, 
administration and troubleshooting.

● You may find that sharing your directly connected printer with other users will slow down your 
computer unacceptably.

TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to 
the network. See Connect a computer to the printer by network (Mac OS X) on page 19.

Uninstall the printer software (Mac OS X)
During the previous Installation step, you have the option to select that . This should be available under 
Hewlett-Packard in the system Applications folder.

IMPORTANT: The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Print & Scan dialog from the system preferences. Select the name 
of the printer and click the – button.
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3 Setting up the printer

● Introduction

● Automatic firmware update

● Turn email notifications on and off

● Turn alerts on and off

● Control access to the Embedded Web Server

● Set Windows driver preferences

● Set up Web Services
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Introduction
This chapter describes various printer settings that the printer administrator may wish to control as soon as a 
new printer is assembled and ready for use.

Automatic firmware update
The printer can automatically check for a firmware update periodically (see Firmware update on page 113). 
Without an update, some Web Services may not be available. The Enable Web Services process includes the 
option to turn on automatic firmware updates from the printer's front panel or Embedded Web Server.

Turn email notifications on and off
In order to receive email notifications from the printer, you must have configured the email server. To 
configure the email server using the Embedded Web Server, select Settings > email alerts, and fill in the 
following fields:

● SMTP server: the IP address or hostname of the outgoing mail server (SMTP) that will process all email 
messages from the printer. If the mail server requires authentication, email notifications will not work.

● Printer email address: each email message sent by the printer must include a return address, which 
does not need to be a real, functional email address, but it should be unique, so that recipients of the 
message can identify the printer that sent it.

You can turn specific email notifications on or off by selecting Notifications from the Tools tab of the 
Embedded Web Server.

Turn alerts on and off
Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of 
your printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility, by 
the printer driver and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.

To access alert settings under Windows

● Select Alert Settings in the Tools menu of the HP Designjet Utility.

● Select Alert Settings in any alert page displayed by the HP Designjet Utility.

● Right-click the system tray icon of the HP Designjet Utility, and select Alert Settings.

In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.
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Alternatively, you can choose when, if ever, to display critical or non-critical alerts.

To access alert settings under Mac OS X

● Open HP Printer Monitor preferences, select your printer, and then Customize Alerts, so that you can 
set each individual alert to appear in specific cases and with a specific time interval.
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You can turn off alerts completely by unchecking the “Show monitor status in menu bar” box in the 
Notifications tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the “Notify 
me when alert appears” box (as below), the alerts will be available in the HP Printer Monitor, but will not pop 
up in the Dock screen.

Control access to the Embedded Web Server
To prevent users from modifying important device settings, you can set a password in the Embedded Web 
Server, so that users without the password can see only the Information tabs. Once set, the password is 
required to view or change any parameters in the other tabs.

Set Windows driver preferences
You can change some default settings in your printer driver according to your own preferences, for instance 
to set color emulation or paper-saving options. To do this under Windows 7, for example, press the Start 
button on your computer's screen, then click Devices and printers, then right-click your printer's icon and 
select Printing preferences. Any settings you change in the Printing Preferences window will be saved as 
default values.

Set up Web Services
Before using Web Services, some setup is required on your printer and your computer.
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1. Make sure that your printer is correctly connected to the Internet.

2. Enable Web Services during initial setup of the printer, or later by swiping down the dashboard, 
touching  and scrolling down and touching Web Services . During the process you will have access to 
an Automatic firmware update Service. It is strongly recommended that you have this service enabled 
and that you have the unit updated with the latest firmware available to ensure the best performance 
possible.

3. This is an optional step: If you are the printer administrator, log in at HP Connected 
(http://www.hpconnected.com) to customize your printer’s email address or manage printer security 
for remote printing.

Congratulations, you now have completed Web Services setup and HP ePrint is ready to use.

For the latest information, support, and terms of use of HP Connected, see http://www.hpconnected.com 
(check your regions's availability).
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4 Personalizing the printer

● Change the language of the front-panel display

● Access the Embedded Web Server

● Change the language of the Embedded Web Server

● Access the HP Utility

● Change the language of the HP Utility

● Change the sleep mode setting

● Change the auto-off setting

● Change the front-panel display brightness

● Configure network settings

● Manage Printer security

● Change your printer’s email address
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Change the language of the front-panel display
To change the language of the front-panel menus and messages, swipe down the dashboard, touch  , 
then scroll down the menu and touch Preferences > Language. Touch your preferred language.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser 
running on any computer.

To access the Embedded Web Server, you must have a TCP/IP connection to your printer. You can access the 
Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a TCP/IP 
connection (wired or wireless).

The following browsers are known to be compatible with the Embedded Web Server:

● Internet Explorer 10 and later

● Mozilla Firefox 35 and later

● Safari 8.x for Yosemite (OS X v10.10), Safari 7.x for Mavericks (OS X v10.9) and Safari 6.x for Mountain 
Lion (OS X v10.8)

● Google Chrome 40 and later

To access the Embedded Web Server on any computer, open your Web browser and type the IP address of 
your printer.

You can see your printer's IP address on the front panel by touching  or  .

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot 
access the Embedded Web Server on page 195.

Change the language of the Embedded Web Server
The default language in which the Embedded Web Server first appears is the language you have selected for 
your browser. If this language is not supported by the Embedded Web Server, the Embedded Web Server will 
appear in English; however, you can change it to any supported language.

The languages supported by the Embedded Web Server are English, Portuguese, Spanish, Catalan, French, 
Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is an 
option at the bottom of the screen to change language.

Access the HP Utility
The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP, or Wi-Fi connection.

● Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs > HP > HP 
Designjet Utility > HP Designjet Utility. This launches the HP Designjet Utility, showing the HP 
Designjet printers installed on your computer.

● Under Mac OS X, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK > Library 
> Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the HP Designjet printers 
installed on your computer.
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When you select your printer in the left pane, everything that appears in the right pane is specific to that 
printer.

Change the language of the HP Utility
The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), 
French, Italian, German, Dutch, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

● Under Windows, the language will be adjusted to your regional language settings as defined in the
Windows Control Panel.

● Under Mac OS X, the language is changed as for any other application. In System Preferences, select
International and re-launch the application.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode 
to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and 
swipe down the dashboard, touch  , then scroll down the menu and touch Sleep mode. Select the wait 
time you want and then touch OK; you can set the time from 5 minutes to 3 hours. The default time is 5 
minutes.

Change the auto-off setting
You can use the printer's auto-off feature to turn the printer off automatically. For example, setting it to 2 
hours would turn the printer off after 2 hours of inactivity. In this way, you can save more energy. However, 
the auto-off feature is automatically disabled when the printer is connected to a network, to avoid 
inconveniencing network users.

If you are using a USB connection, you can set the printer to turn itself off completely after 2 to 12 hours of 
inactivity. At the front panel, swipe down the dashboard, touch  , then scroll down the menu and touch 
Auto power off.

Change the front-panel display brightness
To change the brightness of the front-panel display, swipe down the dashboard, touch  , then scroll down 
the menu and touch Preferences > Screen brightness, and select a value you want. Touch Done to set the 
value.

Configure network settings
You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front 
panel.

● From the Embedded Web Server: Select the Network tab.

● From the HP Utility: You can access the Embedded Web Server through the HP Utility.

● From the front panel: swipe down the dashboard, touch  , then scroll down the menu and touch
Network setup.

The following options are available:
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● Enable/Disable wireless turns the wireless connection on or off.

● Wireless setup wizard provides an easy way to connect to a wireless network.

● Wi-Fi protected setup allows you to set up a connection with a wireless network using WPS 
(pushbutton or pin) encryption.

● Network summary displays information about the wired or wireless network

● Print network configuration

● Advanced setup

◦ Select I/O timeout sets the time that the printer will wait for the driver to send a job to the printer 
once the connection has been opened. Values range from half a minute to half an hour.

◦ Link speed sets the speed at which data are transmitted over the network. The default is 
Automatic.

◦ IP settings allows you to view or change the IP address, subnet mask, default gateway, and DNS 
address.

◦ Hostname allows you to change the hostname.

● Restore network defaults

Configure firewall settings
Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides 
simple control of IP addresses that are allowed access.

NOTE: In addition to firewall protection at the network layer, the printer also supports open secure sockets 
layer (SSL) standards at the transport layer for secure client-server applications, such as client-server 
authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP traffic. 
Firewall policy pages are accessed through the Embedded Web Server and displayed by your Web browser. 
After a policy is configured, it is not activated until you click Apply in the Embedded Web Server.

Creating and using firewall rules

Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP traffic based on IP 
addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those 
addresses and services.

Create a firewall rule

1. Open the Embedded Web Server.

2. Click the Settings tab, then Firewall Rules.

3. Click New, and then follow the onscreen instructions.
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NOTE: After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted 
for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be 
enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web 
Server.

Change the priority of firewall rules

1. Open the Embedded Web Server.

2. Click the Settings tab, then Firewall Rules Priority.

3. Select the priority from the Rule Precedence list, with 10 having the highest priority and 1 having the 
lowest priority.

4. Click Apply.

Change firewall options

1. Open the Embedded Web Server.

2. Click the Settings tab, then Firewall Options.

3. Change whatever options you wish, then click Apply.

NOTE: After you click Apply, the connection to the Embedded Web Server might be temporarily disrupted 
for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be 
enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web 
Server.

Reset firewall settings

To reset the firewall settings to the factory defaults, restore the printer’s network settings.

Limitations to rules, templates, and services

When creating firewall rules, note the following limitations to rules, templates, and services.

Item Limit

Maximum number of rules 10 (one default rule)

Maximum number of Address Templates 12

Maximum number of user-defined address templates 5

Maximum number of services you can add to a user-defined service template

NOTE: The predefined All Services template is not subject to this limitation and includes all 
services supported by the print server.

40

Maximum number of services you can add to the policy

NOTE: For a given rule, only one address template and one service template can be added.

40

Maximum number of service templates in the policy 10

Maximum number of user-defined custom service templates 5
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Reset network settings

To reset the administrator password and network settings, go to the front panel, swipe down the dashboard 
and touch  , then scroll down the menu and touch Network setup > Restore network settings.

NOTE: Print the network configuration page and check that the network settings have been reset.

NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings.

Manage Printer security
When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your 
printer's email address can print to your printer by just sending a file to it. Although HP provides a spam 
filtering service, you should be careful about giving out your printer's email address, as everything sent to 
that address may be printed on your printer.

If you are the printer administrator, you can manage Printer security or change your printer status to lock 
mode by visiting HP Connected at http://www.hpconnected.com (check your region's availability). You can 
also customize your printer's email address and manage print jobs from there. At your first visit, you will 
need to create an account in HP Connected.

Change your printer’s email address
You can change your printer's email address at HP Connected: http://www.hpconnected.com (check your 
region's availability).
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5 Paper handling

● General paper-loading advice

● Load a roll onto the spindle

● Load a roll into the printer

● Unload a roll

● Load a single sheet

● Unload a single sheet

● Use the multi-sheet tray

● View information about the paper

● Maintain paper

● Change the drying time

● Turn the automatic cutter on and off

● Form feed with or without cutting
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General paper-loading advice
You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of 
single sheets from the multi-sheet tray. Only one of these methods can be used at a time, and switching from 
one to another is manual: it is not done automatically.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer 
from moving.

CAUTION: All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be loaded in landscape 
orientation.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the bin closed throughout the loading process.

Load a roll onto the spindle
1. Open the roll cover.
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2. Remove the spindle from the printer.

WARNING! Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a 
new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from 
the end of the spindle.

4. If the roll is long, rest the spindle horizontally on a table and load the roll on the table.
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5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove 
the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing 
the correct orientation.

NOTE: From the front of the printer, the blue stopper is inserted into the left-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll. The 
roll cannot exceed the blue hub as illustrated below.

7. Ensure the blue paper stop is pushed in as far as it goes. Check that there is no space between the roll 
and the stops at both ends.
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IMPORTANT: Make sure that the roll does not exceed the blue hub.

NOTE: The printer only accepts rolls with 2–inch cores. For further details on roll specifications, see 
Table 24-2 Paper specifications on page 204.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of 
different paper types on different spindles. Extra spindles are available for purchase, see Accessories 
on page 119.

Load a roll into the printer
To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle 
on page 36.

1. From the front panel, select the paper tab, touch  , then touch Load roll and follow the front panel 
instructions.

This step is optional: if you just start feeding in roll paper, the printer recognizes that you want to load a 
roll.

2. Make sure the cover is open.

3. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as viewed 
from the front of the printer.
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4. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the 
paper slightly and cut a straight edge.

5. Insert the edge of the paper into the printer.

WARNING! Do not push your fingers inside the printer's paper path.

6. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer 
detects the paper, it beeps, and feeds in the paper automatically.

7. The front panel prompts you to select the paper category and type.

8. If you do not see your paper type in the front panel, touch More paper types.

If you still cannot find your paper type in the whole list, see The paper type is not in the driver 
on page 126.

40 Chapter 5   Paper handling ENWW



9. The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow the 
instructions on the front-panel display.

10. Close the roll cover.

11. Touch OK when ready.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper cannot be 
loaded successfully on page 124.

Unload a roll
If there is paper on the roll, you can unload it from the front panel: touch the paper tab, touch  , then 
Unload a roll and touch OK when ready.

If the end of the paper is no longer attached to the core, the front panel asks you to unload the roll manually.

After unloading, the multi-sheet tray is the default active paper source.

Confirm the paper type and size loaded on the multi sheet tray.

Load a single sheet
NOTE: Roll paper and single sheets use the same input slot in the printer.

NOTE: Sheets of width 329 mm (12.95 in) or less should be loaded from the multi-sheet tray.

1. At the front panel, touch the paper tab, touch  , then Load single sheet.

2. If a roll is loaded, you have to first touch Unload roll and wait while it is automatically unloaded.

3. Open the roll cover.

NOTE: You do not need to unload the roll and spindle to load a single sheet.

4. Insert the sheet into the right-hand side of the input slot.

WARNING! Do not push your fingers inside the printer's paper path.
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5. Align the sheet with the blue line.

Feed the paper into the printer. Feed the paper into the printer until you feel resistance and the paper 
bends slightly. When the printer detects the paper, it beeps, and feeds in the paper automatically

6. Touch OK on the front panel to continue.

7. Select your paper category and type. If you do not see your paper type in the front panel, touch More 
paper types. If you still cannot find your paper type in the whole list, see The paper type is not in the 
driver on page 126.

8. The printer checks the alignment and measures the sheet.

NOTE: Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper cannot 
be loaded successfully on page 124.

Unload a single sheet
To unload a sheet, go to the front panel and touch the paper tab, touch  , then Unload single sheet.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the bin.

After unloading, the multi-sheet tray is the default active paper source.

Use the multi-sheet tray
1. If no roll is loaded or the roll has run out of paper, the multi-sheet tray is active by default.

Alternatively, at the front panel, touch  , then Use multi-sheet tray. If a roll or single sheet is already 
loaded, you have to wait while it is automatically unloaded.
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2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and the 
second extension for A3 paper.

3. Adjust the output tray extensions depending on the length of the paper.

4. Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are all 
of the same size.
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5. Adjust the tray to fit the width of the paper.

View information about the paper
To view the loaded paper information, touch the icon of the active paper source.

The following information is displayed on the front panel:

● Paper type you have selected

● Roll or sheet status

● Width of the paper in millimeters (estimated)

If no roll or no single-sheet paper is loaded, or there is no paper in the multi sheet tray, the message Status: 
Not ready and Out of paper is displayed.

Maintain paper
To maintain paper quality, follow the recommendations below.

● Store rolls covered by another piece of paper or cloth

● Store cut sheets covered and clean or brush them before loading them in the printer

● Clean input and output platens

● Always keep the top cover of your printer closed

NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched 
on page 147.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints 
where time is of higher importance or when you need to be sure ink is dry before handling.

Swipe down the dashboard and touch  , scroll the menu and touch Print retrieval > Select drying time. 
You can select:

● None, to disable the drying time and remove your print as soon as it finishes printing

● Optimized, to set the default and recommended time for your selected paper (this is the default 
setting)

● Extended, to set a longer than recommended time to ensure ink is completely dry
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CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks on 
the print.

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away 
due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper 
and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does 
not cut the paper until the printhead maintenance has finished.

Turn the automatic cutter on and off
To turn the printer's paper cutter on or off, go to the front panel, swipe down the dashboard and touch  , > 
Print retrieval > Enable cutter and change the cutter option.

The default setting is On.

NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper 
on loading and unloading rolls.

TIP: To cut roll paper while the automatic cutter is disabled, see Form feed with or without cutting 
on page 45.

Form feed with or without cutting
If you go to the front panel, swipe down the dashboard and touch  , then scroll down the menu and touch 
Form feed, the printer advances. If you select Form feed and cut, the printer advances the paper and makes 
a straight cut across the front edge. There are at least two possible reasons why you might want to do this.

● To trim the leading edge of the paper if it is damaged or not straight.

● To feed and cut the paper when the automatic cutter has been disabled.

NOTE: The printhead is serviced after each print, and the paper cannot be cut until the process completes, 
so you may notice a delay.

CAUTION: Remove the cut piece from the output platen. If strips or short prints are left on the output 
platen, the printer could jam. Check also that there are no pieces of paper in the cutter guide.
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NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched 
on page 147.

To advance the paper without cutting it, go to the front panel, swipe down the dashboard and touch  , 
then scroll down the menu and touch Form feed
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6 Printing

● Print from USB

● Print from a computer using a printer driver

● Advanced print settings

● Color management
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Print from USB
1. On the front panel, touch the Print tab. If you haven’t connected your USB flash drive yet, a message will 

prompt you to do it.

2. Touch Print from USB. A list of the documents that can be printed will appear, and you can sort them by 
touching :

a. Name

b. Date

c. Size

d. Type (JPEG, TIFF, HP-GL/2)

3. You can also search for the file by name. A keyboard will pop up; type the name of the file and touch 
Find.

4. If an HP-GL/2 file is selected, the following screen will appear:

Touch the name of the file you want to print. You can choose how many copies you want to make or 
enter the name manually. You can also choose the paper source (single sheet, multi-sheet, paper roll). 
Once you have selected the settings, touch Print to start printing the document. To cancel the job in 
process, touch X.
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5. If you are printing an image, touch the name of the image you want to print. By touching the image, you 
can now edit the image settings, to change the brightness or rotate the image. You can also select the 
color settings. Once you have selected the correct settings, touch Start Print to print.

Print settings
By swiping down the dashboard and touching  , you can modify the settings. The settings available are as 
follows:

● Tray or paper

● Color

● Quality

● Resize

● Margin

You can save the new settings as default by touching Save current settings.

Mobile printing
You can also print from your smartphone or tablet. See Mobile printing on page 79 for more information
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Print from a computer using a printer driver
This is the traditional way of printing from a computer. The correct printer driver must be installed on the 
computer (see Connecting the printer on page 17), and the computer must be connected to the printer by 
network or by Wi-Fi.

When the printer driver has been installed and the computer is connected to the printer, you can print from a 
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings
The rest of this chapter explains the various print settings that you can use. These methods offer a relatively 
large number of settings in order to satisfy all requirements.

TIP: In general you are recommended to use the default settings unless you know that they do not meet 
your requirements.

TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under a 
name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the 
Windows printer driver.

Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed, while 
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and 
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also 
select Economode, the fastest printing mode which uses a lower rendering resolution and consumes less ink. 
It therefore increases printing speed even further, but reduces print quality. Economode can be selected only 
from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See 
High-quality printing on page 54.

NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print 
Quality Options dialog box (select Custom options and then Settings).

You can select print-quality options in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. If you 
select Standard Options, you will see a simple slider with which you can select speed or quality. If you 
select Custom Options, you will see the more specific options described above.

● In the Mac OS X Print dialog: go to the Paper/Quality panel and look at the Quality Options section. If 
you select Standard quality options, you will see a simple slider with which you can select speed or 
quality. If you select Custom quality options, you will see the more specific options described above.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already 
received (even if they have not started to print yet).
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Select paper size
The paper size can be specified in the following ways.

NOTE: The paper size specified here should be the paper size in which the document was created. It is 
possible to rescale the document to a different size for printing. See Rescale a print on page 53.

● In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the 
Document Size list.

● In the Mac OS X Page Setup dialog: select your printer from the Printer list, then select your paper size 
from the Paper Size list.

NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various 
different ways to specify it.

Use the Windows printer driver

1. Select the Paper/Quality tab.

2. Touch the Custom button.

3. Enter the name and dimensions of your new paper size.

4. Touch OK. The new paper size is automatically selected.

A custom paper size created in this way has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● The paper size is local to the printer queue. It will not be seen from other printer queues in the same 
computer.

● In Domain server networks, the paper size is local to the computer. It will not be seen from other 
computers sharing the printer queue.

● In Workgroup networks, the paper size will be shared among all the computers sharing the printer 
queue.

● If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms

1. From the Start menu, or from the Control Panel, select Devices and Printers, then Select Printer.

2. In the Forms tab, check the Create a new form box.

3. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

4. Touch the Save Form button.

5. Go to the printer driver, and select the Paper/Quality tab.
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6. Select More… from the drop-down list of paper sizes.

7. Select your new paper size from the group of Custom sizes.

A custom paper size created in this way has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● Restricted users cannot create paper forms. The “manage documents” role in the Windows Active 
Directory is the minimum required.

● The paper size is local to the computer. It will be seen in all the printer queues that have been created 
on the computer and that support paper of that size.

● If a printer queue is shared, this paper size will appear in all the client computers.

● If a printer queue is shared from another computer, this paper size will not appear on the driver´s 
document size list. A Windows form in a shared queue needs to be created in the server.

● If the printer queue is deleted, the paper size is not deleted.

Use the Mac OS X printer driver

1. Go to the Page Setup dialog.

NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

2. Select Paper Size > Manage Custom Sizes.

Select margins options
By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper, 
increased to 17 mm at the foot of cut-sheet paper. However, you can change this behavior in several ways.

● In the Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.

● In the Mac OS X Print dialog: select the Margins/Layout panel.

You will then see at least some of the following options.

NOTE: Under Mac OS X, the available margins options depend on the paper size selected.

● Standard. Your image will be printed on a page of the size you have selected, with the default margin 
between the edges of the image and the edges of the paper. The image should be small enough to fit 
between the margins.

● Oversize. You should load paper that is larger than the size you selected in the application or driver. If 
you cut off the margins after printing, you will be left with a page of the size you selected, with no 
margins remaining between your image and the edges of the paper. This is useful when you want your 
image to cover the whole area of the paper.

● Clip Contents By Margins. Your image will be printed on a page of the size you have selected, with the 
default margin between the edges of the image and the edges of the paper. In this case, if the image is 
the same size as the page, the printer assumes that the extreme edges of the image are either white or 
unimportant, and do not need to be printed. This may be useful when your image already contains a 
border.
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Print on loaded paper
To print a job on whichever paper is loaded in the printer, select Use printer settings/Any in the Paper Type 
option of your printer driver.

● In the Windows driver dialog: select the Paper/Quality tab, then select Use printer settings in the 
Paper Type drop-down list.

● In the Mac OS X Print dialog: select the Paper/Quality panel, then select Any in the Paper Type drop-
down list.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size 
(normally larger). This may be useful:

● If your software does not support large formats

● If your file is too large for the printer's memory—in this case, you can reduce the paper size in your 
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

● In the Windows driver dialog: go to the Layout/Output tab and look at the Resizing Options section.

◦ The Print document on option adjusts the image size to the paper size you have selected. For 
example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is 
enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image 
to fit the A4 size.

◦ The % of actual size option enlarges the printable area of the original paper size (the page minus 
the margins) by the percentage indicated, then adds the margins to create the output paper size.

● In the Mac OS X Print dialog: select the Paper Handling panel, then Scale to fit paper size, and select 
the paper size to which you want to scale the image. If you want to increase the size of the image, make 
sure that the Scale down only box is unchecked.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise 
the image will be clipped.

Print a draft
You can specify fast draft-quality printing in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move 
the print-quality slider to the extreme left ('Speed').

● In the Mac OS X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the 
extreme left ('Speed').

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for 
documents containing only text and line drawings.

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Select 
Custom Options, then set the quality level to Fast and check the Economode box.

● In the Mac OS X Print dialog: go to the Paper/Quality panel and set the quality options to Custom, then 
set quality to Fast and check the Economode box.
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High-quality printing
You can specify high-quality printing in the following ways:

● In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move 
the print-quality slider to the extreme right ('Quality').

● In the Mac OS X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the 
extreme right ('Quality').

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print 
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail 
option. This option is available only if you are printing on glossy paper and you have selected Best print 
quality.

● In the driver dialog (Mac OS X Print dialog): select Custom instead of Standard print-quality options, 
then check the Maximum Detail box.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the 
amount of ink used.

Use paper economically
You may be able to save some roll paper by using the following options:

● In the Windows driver dialog: select the Layout/Output tab and then Remove Blank Areas and/or 
Rotate by 90 degrees or Autorotate.

● In the Mac OS X Print dialog: select the Finishing panel, then Remove Blank Areas.

Use ink economically
Here are some recommendations for making economical use of ink.

● For draft prints, use plain paper and move the print-quality slider to the left end of the scale ('Speed'). 
For further economy, select custom print quality options, then select Fast and Economode.

● Clean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount 
of ink.

● Leave the printer permanently turned on so that it can maintain the printhead in good condition 
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not 
done, the printer may need to use much more ink later to restore the health of the printhead.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses 
some ink, and its frequency is related to the number of passes made by the printhead.

Color management
Your printer has been engineered with advanced hardware and software features to ensure predictable and 
dependable color results.
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● State-of-the-art HP printheads and HP inks

● Dedicated color resources for most available paper types

● Color emulation of other HP Designjet printers

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when 
you print an image, you see very similar colors as when you view the same image on your monitor. Color 
management is highly dependent on the paper type loaded at the printer, so please select the correct preset 
for the paper type you are using.

The color management options for your printer can be selected from the Color menu in the Windows driver 
dialog or from the Color Options panel in the Mac OS X Print dialog. In some applications you can make the 
choice in the application itself. Please consult the HP Support Center for guidance on how to use the color 
management options of your particular application.

● Application-Managed Colors: In this case your application program must convert the colors of your 
image to the color space of your printer and paper type, using the ICC profile embedded in the image 
and the ICC profile of your printer and paper type.

● Printer-Managed Colors: In this case your application program sends your image to the printer without 
any color conversion, and the printer converts the colors to its own color space. The color management 
in the printer is done using a set of stored color tables. ICC profiles are not used. This method can 
produce very good results with supported HP paper types. There are two color spaces that the printer 
can convert to its own color space using the stored color tables: sRGB and Adobe RGB.

◦ sRGB emulates the characteristics of the average computer monitor. This standard space is 
endorsed by many hardware and software manufacturers, and has become the default color space 
for many scanners, cameras, printers, and software applications.

◦ Adobe RGB provides a larger color gamut than sRGB. Use this space if you need to do print 
production work with a wide range of colors.

Printer emulation
If you want to print a particular job and to see approximately the same colors that you would get from 
printing the same job on a different HP Designjet printer, you can use the emulation mode provided by your 
printer.

NOTE: Printer emulation is available only when printing an HP-GL/2 job on plain or coated paper. It is not 
available from Mac OS X.

In the Windows HP-GL/2 driver dialog, select the Color tab, then Printer Managed Colors, then select Printer 
Emulation from the Source Profile list. You can then select from the Emulated Printer list.

Printing in grayscale or black-and-white
You can convert all colors in your image to shades of gray in the following ways:
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● In your application program: Many applications provide this option.

● In the Windows driver dialog: Go to the Color tab and look at the Color Options section. Select Print in 
Grayscale. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case 
colored inks are used to compose the gray shades. You can also select Print in pure black and white if 
you want only black and white output with no gray shades. In this case, only black ink will be used for 
printing. The Print in pure black and white option is not supported when printing on glossy paper.

● In the Mac OS X Print dialog: Go to the Color Options panel and select Grayscale from the Mode drop-
down list. Only the black ink will be used for printing, except if the paper loaded is glossy, in which case 
colored inks are used to compose the gray shades. You can also select Pure black and white if you want 
only black and white output with no gray shades. In this case, only black ink will be used for printing. 
The Print in pure black and white option is not supported when printing on glossy paper.
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7 Scanning

● Paper types suitable for scanning

● Scan to file

● Scan settings

● Scan options setup process
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Paper types suitable for scanning
The scanner may not support the full range of paper types that may be used by the printer. The following 
paper categories are supported by the scanner.

● White paper any matte original printed with inkjet technology.For instance, anything printed with this 
printer on any of these paper types: HP Universal Inkjet Bond Paper, HP Coated Paper, HP Heavyweight 
Coated Paper, plain paper.

● Photo paper glossy and satin originals. Inkjet, offset, and traditional photo technologies are supported. 
For instance, any photo or other image printed on any of these paper types: HP Universal High Gloss 
Photo Paper, HP Premium Instant Dry Gloss/Satin Photo Paper. However, for some specific photo 
originals, completely accurate results may not be achieved.

CAUTION: Photo and glossy papers may be scratched while passing through the scanner.

● Translucent paper semi-transparent tracing papers (> 65 g/m²), including HP Natural Tracing Paper, HP 
Vellum, and HP Translucent Bond.

● Blueprints for scanning blueprint originals with optimum results, in grayscale only. This option greatly 
enhances the contrast of the resulting image.

The following paper types are not supported by the scanner:

● Film

● Backlit material

● Cling material

● Translucent paper (< 65 g/m²)

WARNING! Do not use documents with staples or rough surfaces/materials than can damage the scanner 
glass

The image that follows is a QR code containing a link to a video to get more information about how to scan.

58 Chapter 7   Scanning ENWW



Scan to file
You can scan to the following destinations:

● to computer

● to network folder

● to email

● to USB

You can start a scanning process in two ways:

1. On the front panel, touch the Scan tab.

2. Select where you would like to store the scanned image.

3. Feed the document directly:

Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if you 
prefer). Align the center of the sheet approximately with the center of the scanner. Use the standard 
size markings to help you.
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NOTE: The maximum length of paper that the scanner can scan depends on the paper width, among 
other options such as scan resolution. An alert is displayed if the maximum length is exceeded.

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically 
grab the sheet and move it into position for scanning. If you feel that the sheet has loaded badly and 
you want to try again, you can pull it out manually.

IMPORTANT: Do not try to feed the scanner while the printer is printing, as only one action can be 
done at a time. Paper will not be accepted by the scanner during printing.

At the front panel, go to the home screen and touch the Scan tab, then select where you would like to 
store the scanned image:

● Into an email. Before using this option, make sure the setup process has been completed. See Scan 
to email setup process on page 65. If the setup process has not been done, the following 
message appears on the front panel:

In this case, you must give the email address(es) to which the scanned job will be sent.
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Scan to email user interface options:

■ Sender

■ Send to:

● Contact

● Group

● Addresses

Swipe down the dashboard and touch  to change scan to email settings. For further information 
on settings go to Scan to email setup process on page 65.

Touch  to eject the already fed document.

Touch Start Scan to start the scanning process.

NOTE: Before starting the process, make sure you have followed the Scan to email setup 
process. The scan to email setuphas to be done from the Embedded Web Server. For more 
information, go to Scan to email setup process on Scan to email setup process on page 65.

NOTE: If the scanned image is larger than the maximum permitted, the printer will ask you if you 
want to try to send it anyway. If you want to change this option, go to the Embedded Web Server 
and select Scan to email setup  Maximum size of email.

● To a network folder. In this case, you must choose a folder accessible through the network.

To create and/or change the folder options, go to the Embedded Web Server, and follow the 
instructions of the Network folder setup process.
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A security PIN can be associated with each folder; check Network folder setup on Scan to network 
setup process on page 66.

Scan to email user interface options:

● Save As

● File name

● Resolution
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Swipe down the dashboard and touch  to change scan to network folder settings. For further 
information on settings go to Scan to network setup process on page 66.

Touch  to eject the already fed document.

Touch Start Scan to start the scanning process.

NOTE: Before starting the process, make sure you have followed the Scan to Network folder 
setup process. The scan to Network folder setuphas to be done from the Embedded Web Server. 
For more information, go to Scan to Network folder setup process on Scan to network setup 
process on page 66.

NOTE: You can also use the Printer Utility to access the Scan to network option.

● To computer. There are two ways of scanning to computer:

a. Webscan. You can scan to computer from the Embedded Web Server. Look for the Scan to 
computer option, then select Webscan.

NOTE: Note that the scan settings available are fewer than the ones for other options.

Touch Start Scan to start the process. Your default browser will open on your computer with 
a PDF viewer with the scanned image. Save it and store on your computer.

NOTE: To be able to Webscan, this option has to be enabled on the Embedded Web Server. 
For more information go to Scan to computer setup > Webscan. See Webscan on page 69.

b. From server and from printer (WSD).

NOTE: This option is available for Windows only.

NOTE: To be able to Scan to computer from server/from printer, this option has to be 
configured on your computer. For more information on Scan to computer from server/ from 
printer setup see From server/from printer on page 70.

● To USB. When scanning to USB, a folder named HPSCANS is created on the USB drive. The file is 
saved in the folder. The file is saved in PDF, JPEG, or TIFF format using an automatically generated 
file name if you have not given it one.
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Scan to USB user interface options:

● Save As (format file

● File name

● Resolution

Swipe down the dashboard and touch  to change scan to USB settings. For further information 
on settings go to Scan settings on page 64.

Touch  to eject the already fed document.

Touch Start Scan to start the scanning process.

● Scanning from a Mobile device.

You can also scan from your smartphone or tablet: See Mobile Printing and Web Services 
on page 12 for more information.

Scan settings
Some of the default scan settings are displayed. Touch Settings to see the complete list of settings, and 
check in particular that the Original type setting corresponds to the paper type that you intend to scan.

Original

● Lighter/Darker: allows you to modify the lightness of the scan using a slider.

● Background noise removal: clears the noise on the original background.

● Background color removal: cleans the color in the original background.

● Blueprint: for scanning blueprint originals with optimum results. This option converts to grayscale and 
inverts the colors, if needed, producing a white background with black lines.

● Translucent Media: is a mode specifically for scanning NTP/vellum/other transluscent media.

Scan settings

● Resolutions: allows you to specify the scan resolution (200, 300, 600 dpi)

● Color options: allows you to choose color, grayscale, or black and white scanning.
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● Auto De-skew : corrects the skew automatically. It is On by default.

● Scan full width (36”): do not crop the scan to the original edges. It is Off by default.

Save settings

● Save as: Format allows you to specify the format of the file in which the scanned image will be saved: 
TIFF, JPEG, or PDF.

● File name

● File compression: allows you to specify the level of compression: High (the default level), Medium, or 
Low. This option is available if the format is JPEG or PDF.

Defaults

● Save current settings

● Restore to factory defaults

When you are satisfied with the scan settings, touch Save current settings, then touch Back to return to 
where you were.

Scan options setup process
A scanned image may be saved in a USB flash drive, in a network folder, or in an email. The USB flash drive 
option requires no preparation, but the other options will not work until they have been set up in the 
following way.

To set up the different scan options, go to the Embedded Web Server in your computer. Access the Embedded 
Web Server by typing the printer’s IP address into your browser. Find your printer’s IP address on your 
printer’s Home screen, on the dashboard. Once in the Embedded Web Server, look for the option you would 
like to set up.

Scan to email setup process
To set up Scan to email, follow the process in the Embedded Web Server.
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Outgoing email settings

To: select the default address destination

From: define the default email address for the sender

Default from: specify the default email name

Default display name: specify the default name for the email sender

SMTP Server: the IP address of the outgoing mail server (SMTP) that will process all email messages from the 
printer. If the mail server requires authentication, email notifications will not work.

SMTP Port: set the default SMTP port number of your outgoing email server

Maximum size of email: defined by your email server

Server Authentication: depends on your email server settings

Scan to network setup process
A scanned image may be saved in a network folder. The USB flash drive option requires no preparation, but 
the other options will not work until they have been set up in the following way. To set up the Scan to 
network folder, first you have to create a folder on your computer.

1. Create a folder on a computer that the scanner can access through the network. See Example: Create a 
scan-to-network folder under Windows on page 70 or Example: Create a scan-to-network folder 
under Mac OS X on page 72.

2. Create a user account on the same computer for the printer.

3. Change the sharing options of the folder so that it is shared with the 'scanner user', and assign full 
control of the folder to that user.

4. Create a share name for the folder.

Once the shared folder is created, go to the Embedded Web Server and follow the instructions under the 
Scan to network folder setup process.
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5. In the printer's Embedded Web Server, select the Scan tab and then Scan to network folder. See Access 
the Embedded Web Server on page 30.

6. Select an existing profile or  to create a new network folder profile.

7. Write a name for the folder and type the network path.

● Display Name is displayed in the front panel when you are choosing the scan destination. It may 
be different from the network or FTP folder name.

● Network Path should contain the network name of the remote computer.

The server and folder names are used to connect to the shared folder by building a network folder 
path as follows: \\server name\folder name

For a Network Path, enter the name or IP address of the remote computer and the name of the 
shared folder.

Select Next to continue.

8. Define Log-in Authentication settings.
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● User name should contain the name of the 'scanner user'.

● Password should contain the password of the 'scanner user'.

Type the user name and password of the 'scanner user' that you have already created on the remote 
computer. Leave the user domain field empty unless the user is a member of a Windows domain. If the 
user is only a local user of the remote computer, leave the field empty. You can use the name (instead 
of the IP address) in the server name field only if the shared folder is on a Windows computer in the 
same local network. This must be a simple name (up to 16 characters long) without a domain suffix 
(without any dots in the name). Fully qualified DNS domain names are not supported. If the product and 
the network folder are in different networks, or if the remote computer is not running Windows, then 
you must use the IPv4 address instead of the name of the remote computer. On IPv6 networks the IPv6 
address is also supported.

Select Next to continue.

9. Define the Setup Configuration for files scanned to the network folder.

NOTE: The scan settings defined for a folder, are exclusive for the setup folder.

Define the scan settings fields for files scanned to the network folder.
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● Original size allows you to resize the print in two different ways: to a percentage of its original 
size, or to fit a particular paper size. The default is 100% (its original size).

● Darkness

Define the file settings fields for files scanned to the network folder.

● Default file name

● Default file type

● Default color preference

● Default output quality

● Default resolution

● Black TIFF compression

● Color/Grayscaale TIFF compression

Click Save only to save the configuration or click Save and Test to save the configuration and perform a 
test to check the network folder is correctly set up.

You can check at any later time that the shared folder remains accessible by clicking Test in the 
Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s 
password is changed, or if the shared folder is moved or deleted.

10. Click Add to save the configuration.

NOTE: If the product has already been configured for scanning to the network and you now want to 
use a different shared folder, click Edit.

Scan to computer
There are two ways to scan to a computer:

● webscan

● from server/from printer

Webscan

To be able to Webscan, this option has to be enabled in the Embedded Web Server. Under the Settings tab, 
look for Webscan from EWS and make sure it is enabled.

1. Under the Settings tab, select Security > Administrator settings.

2. Under Printer features, choose an option:

◦ Enable all.

◦ Printer settings > Webscan from EWS.

Select Apply.
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From server/from printer
To be able to scan from server/from printer, you have to follow Windows setup process defined for adding a 
device.

Look for Devices and printers > Add a device and follow the instructions.

Example: Create a scan-to-network folder under Windows
1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user 

account for this purpose, but it is not recommended.

2. Create a new folder on the remote computer, unless you want to use an existing folder.

3. Right-click the folder and select Properties.
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4. In the Sharing tab, click the Advanced Sharing button.

5. Check the Share this folder box.
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6. You need to ensure that the 'scanner user' has full read/write control over the shared folder. To do this, 
click Permissions and grant Full Control to the user (or to any suitable group that includes that user).

7. If there is a Security tab in the Properties window for your folder, then you must also grant the same 
user Full Control over the folder in the Security tab. Only some file systems such as NTFS require this.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to 
send scans to the folder.

Example: Create a scan-to-network folder under Mac OS X
1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user 

account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, Mac OS X users have a Public folder that 
can easily be used for this purpose.

72 Chapter 7   Scanning ENWW



3. Open the System Preferences application and select the Sharing icon.

4. Make sure the 'scanner user' has Read & Write access to the folder.

5. Click Options.

6. Check the Share files and folder using SMB box, and make sure that the 'scanner user' is checked in the 
On column.
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7. Click Done. You will now see file sharing enabled and Windows sharing on.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to 
send scans to the folder.

Mobile scanning
You can also scan from your smartphone or tablet. See Mobile printing on page 79 for more information.
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8 Copying

● Copy

● Copy settings
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Copy
1. On the front panel, touch the Copy tab.

2. Touch the suitable option for your document. The options are the following:

● Lines

● Image

● Mixed (a document that has both images and lines, such as a map)

3. Select the number of copies that you want to make. You can choose a number ranging from 1 to 99. You 
can enter the number manually or select it from a slider.

4. Select the paper source you are going to copy to:

● Roll

● Multi-sheet tray

● Single sheet

5. Select the quality of your copy. There are 3 different quality options: Best, Normal, Draft.
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6. Touch Copy. The printer will prompt you to load the original document if you haven’t already.

NOTE: The maximum length of paper that the scanner can scan depends on the paper width and the 
scan resolution. An alert is displayed if the maximum memory is exceeded.

Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically 
grab the sheet and move it into position for scanning. If you feel that the sheet has loaded badly and 
you want to try again, you can pull it out manually.

IMPORTANT: Do not try to feed the scanner while the printer is printing, as only one action can be 
done at a time. 

Copy settings
Some of the default copy settings are displayed. Touch Settings to see the complete list of settings:

Original settings

● Content type

● Lighter/darker allows you to adjust the lightness of the copy.

● Background noise removal reduces image defects such as wrinkles.

● Background color removal reduces color defects in the original background.

● Blueprint for copying blueprint originals with optimum results. This option converts images to 
grayscale and inverts the colors, if needed, producing a white background with black lines.

● Translucent Media is a mode specifically for copying images that are on NTP/vellum/other translucent 
media, as opposed to opaque media, to obtain optimum results.
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Scanning

● Color options allows you to specify the colors for your copy (color, grayscale, black and white).

● Auto De-Skew automatically corrects skew. It is On by default.

● Scan full width 36in ensures the copy is not cropped to the edge of the original image. It is Off by
default.

Printing settings

● Resize allows you to resize the print. There are two options: resize to a percentage of the original size,
or to fit the copy to a particular paper size. The default is 100% (the original size).

● Paper Source allows you to choose between Roll, Multi-sheet Tray or Single Sheet when printing.

● Copy Margins allows you to decide how to manage the printer margins. You can print the scanned
image as is and add the margins or you can clip the image with the printing margins (Add to Contents,
Clip to Contents). .

● Quality defines the copy resolution and print quality.

Defaults

● Save current settings

● Restore to factory defaults

When you are satisfied with the scan settings, touch Save current settings, then touch Back to return to the 
previous screen.
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9 Mobile printing

Mobile printing
You can print to your printer from many mobile devices and from almost any location. There are two main 
methods of Mobile Printing:

● Direct printing by connection to the same network

● Printing by email

Your printer can be connected to the Web, providing various benefits:

● Automatic firmware updates (see Firmware update on page 113)

● Print on HP Printers from almost anywhere

● Print on HP Printers from almost any device, including smartphones, tablets, and laptops

See http://www.hp.com/go/designjeteprinters for more detailed information.

You can enable Web Services when setting up the printer: see Set up Web Services on page 26 or the 
Assembly Instructions for more information.

IMPORTANT: The printer must be connected to a network: connect an Ethernet cable for a wired 
connection, or start the Wireless Wizard in the Connectivity menu for a wireless connection. See Connecting 
the printer on page 17.

Print from in-OS (internal Operating Systems)
iPhone, iPad

Printing with AirPrint™ is simple, all you have to do is make sure your device and printer are operating on the 
same network and follow the steps below.

1. Choose your content. Open the document or photo you want to print, tap the share button.

2. Select print icon. Swipe screen to reveal print button on bottom now, then tap the print icon.

3. Print! Confirm the correct printer and print setting are selected. Tap Print and collect your documents.
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All Android

Printing with Android device is simple and depending on your model, printing may already be preloaded on 
your device. If it is not, all you need to do is download the HP Print Service Plugin from the Google play store 
to get started.

1. Choose your content. Open the document or photo you want to print, tap the menu icon and select 
Print.

2. Choose your printer. Select from the list of printers that appears.

3. Print! Confirm the correct printer and print setting are selected. Tap Print and collect your documents.

Print by email (HP ePrint)
If you can email it, you can print it. Simply attach a PDF or other print-ready file to an email message, and 
send it to your printer’s dedicated address.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. 
There are a few limitations that you should bear in mind:

● The attached files to be printed must be in PDF, JPEG, or TIFF formats.

● The maximum file size is 10 MB, but your email server may have a lower limit.

● Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally 
in portrait orientation (some printers may offer autorotation)..

Print, Scan and Share from All in One Remote App
Use the screen on your mobile device to control printer scan and print functions. Send scans directly to your 
mobile device from your printer. Print PDF, photos, email attachments, and more from virtually anywhere.

NOTE: Mobile devices must have an Internet connection and email capability.

Scan and copy control requires that the mobile device and printer be on the same wireless network or have a 
wireless-direct connection to the printer.

Apple/Android printing with AiO

1. Choose your content. Open the document or photo you want to print, tap the share icon and select AiO .

2. Open in All in One Remote. Go to settings to adjust Quality or Color Mode if necessary.

3. Print. Confirm the correct printer and print setting are selected. Tap Print and collect your documents.

Apple/Android scanning and sharing with AiO

1. Load paper to be scanned. Place the document that you want to scan on the printer.

2. Open in All in One Remote. Trigger scanning from the app. You can store the document in your mobile 
device.

3. Share. Select sharing through email or your preferred repository.
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Mobile specifications
● Mobile devices must have an Internet connection and email capability.

● Scan and copy control requires that the mobile device and printer be on the same wireless network or 
have a wireless-direct connection to the printer.

● Printing requires an Internet connection to an HP printer.

● iOS 7.0 and above, or Android KitKat4.4 and above, is required.
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10 Practical printing examples

● Print from Adobe Acrobat

● Print from Autodesk AutoCAD

● Print from Adobe Photoshop

● Print and scale from Microsoft Office
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Print from Adobe Acrobat
1. In the Acrobat window, move the mouse cursor to the bottom left corner of the document pane until the 

document size appears there.

2. Select File > Print and ensure that Page Sizing is set to Actual size.

NOTE: The page size will not be automatically selected according to the document size.
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3. Press the Properties button and then select the Paper/Quality tab.

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom 
paper size, press the Custom button.
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5. Select the Layout/Output tab, and then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print from Autodesk AutoCAD
1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.
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2. Click the Plot icon at the top of the window.

3. The Plot window opens.
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4. You can see further options by pressing the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD 
viewport objects that are sent for printing.

5. Press the Properties button.
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6. Select the Device and Document Settings tab, and press the Custom Properties button.
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7. In the Paper/Quality tab, select the paper type that you intend to use.

8. Select the print quality (your own choice between speed and quality of printing).

9. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the 
Margins/Layout button and select Clip contents by margins.
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10. Select the Layout/Ouput tab, then select the Autorotate option. Autorotation can help to avoid wasting 
paper.

11. Press the OK button and save your configuration changes to a PC3 file.

Using printer emulation
Printer emulation can be requested by selecting Color > Color management > Printer Managed Colors > 
Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins
You can select this margins option from Paper/Quality > Margins/Layout > Print with margins > Layout > 
Clip contents by margins.
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Use this option when the contents to be printed have white borders and a size equal to that of the paper you 
have selected. The printer will use the white border for its margins and you will get a page of size equal to 
that which is selected in the driver.

Print from Adobe Photoshop
1. In Photoshop CS6 select File > Print and then select your printer.
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2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, press the Custom button. Enter the width, the 
length and the name of your custom paper size. Press the Save and OK buttons.
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3. You may wish to change the default paper source, paper type and print quality.
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4. In the Color tab, the default color management option is Printer managed colors, and this is the correct 
option because you have already selected Printer Manages Colors in Photoshop.

Print and scale from Microsoft Office
This section demonstrates how to print and scale from Microsoft Office 2013

Using PowerPoint
1. Select the File tab, then Print, and select the name of your printer.
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2. Select Printer Properties > Layout/output > Fit to to scale the document to a particular size.

3. Select the Paper/Quality tab, then select Paper Source and Paper Type.
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4. Select Margins/Layout, then select Clip contents by margins to keep the size.

Using Project
1. Select File> Print.

2. Select Page Setup, and choose the Paper Size you want.
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3. Select Options to go to the printer driver. The default options in the Paper/Quality tab are probably 
suitable: Paper source: Use printer settings and Paper Type: Use printer settings.

4. Select Layout/Output > Fit to to scale the document to a particular size. Alternatively, you can scale 
the document in Project.
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Using Excel
1. Select the Page Layout tab, then Size, and choose the paper size you want.

2. Select the File tab, then Print, and select the name of your printer.
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3. Select Printer Properties to go to the printer driver. In the Paper/Quality tab, select Paper source, 
Paper Type and Print Quality.

4. Select Layout/Output > Fit to to scale the document to a particular size. Alternatively, you can scale 
the document in Excel.
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11 Handling ink cartridges and printhead

● About the ink cartridges

● Storage of anonymous usage information

● Check ink cartridge status

● Replace an ink cartridge

● About the printhead
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About the ink cartridges
Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper. To 
purchase additional cartridges, see Accessories on page 119.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see 
the Glossary on page 209). Avoid touching pins, leads and circuitry.

Storage of anonymous usage information
Each ink cartridge contains a memory chip that assists in the operation of the printer. In addition, this 
memory chip stores a limited set of anonymous information about the usage of the printer, which can include 
the following: the date when the cartridge was first installed, the date when the cartridge was last used, the 
number of pages printed using the cartridge, the page coverage, the frequency of printing, the printing 
modes used, any printing errors that may have occurred, and the product model. This information helps HP to 
design future products to meet our customers' printing needs.

The data collected by the memory chip does not include information that could be used to identify a 
customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling 
program (HP Planet Partners: http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The 
sampled memory chips are read and studied in order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party 
possessing the cartridge may be able to access the anonymous information on the memory chip. If you prefer 
to not allow access to this information, you can render the chip inoperable. However, after you render the 
memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's ability 
to collect printer usage information. To do so, access the Embedded Web Server, and select Settings > 
Anonymous Usage Information Storage. This does not prevent the cartridge from working normally in other 
respects. However, if you change your mind later, you can restore the factory defaults to resume collecting 
printer usage information.

Check ink cartridge status
To view the ink levels of your ink cartridges, touch the Dashboard status on the front panel and touch .

Touch the desired ink level for more information.

You can also get this information from the HP Utility.

● In the HP Designjet Utility for Windows, go to the Supplies tab to see each cartridge's status.

● In the HP Utility for Mac OS X, select Supplies Status in the Information group.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 182.

if you touch Replace Inks, the printer will give you step-by-step instructions to replace the ink cartridges. 
See Replace an ink cartridge on page 103for more information.
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Replace an ink cartridge
There are two occasions when you need to replace an ink cartridge.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you 
can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one. 

1. Make sure the printer is turned on.

2. Open the ink cartridge cover on the rear right-hand side of the printer.

3. Remove the ink cartridge.

4. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same 
colored letter as the cartridge you are installing.

5. Close the ink cartridge cover.
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About the printhead
The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto 
the paper.

CAUTION: Observe precautions when handling the printhead, because it is an ESD-sensitive device (see the 
Glossary on page 209). Avoid touching pins, leads, and circuitry.

For information on replacing printheads, see Replace the printhead on page 108.
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12 Maintaining the printer

● Check printer status

● Take care of the printer

● Clean the exterior of the printer

● The Print Quality Diagnostic Report

● Clean the printhead

● Align the printhead

● Replace the printhead

● Recalibrate the paper advance

● Move or store the printer

● Firmware update

● Software update

● Printer maintenance kits

● Clean the scanner scanbars

● Calibrate the scanner
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Check printer status
You can check the current status of the printer in various ways:

● If you start the HP Utility and select your printer, you see a page of information describing the status of 
the printer and its paper and ink supplies.

● If you access the Embedded Web Server, you see information about the general status of the printer. 
The Supplies page in the Main tab describes the status of the paper and ink supplies.

● From the front panel, you can get information about the loaded paper and the ink levels.

Take care of the printer
The printer is not designed for any purpose other than printing, and you are not recommended to use it as a 
table, for two reasons:

● The surface can easily be damaged.

● Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal 
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you 
clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

The Print Quality Diagnostic Report
The Print Quality Diagnostic Report consists of two test patterns designed to highlight printhead reliability 
problems. It helps you to check the performance of the printhead that is currently installed in your printer, 
and whether it suffers from clogging or alignment problems.

To print the Print Quality Diagnostic Report:

1. Use the same paper type that you were using when you detected a problem. The test patterns are 
easiest to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View 
information about the paper on page 44.

3. At the printer's front panel, swipe down the dashboard and touch  , then scroll down the menu and 
touch Image Quality Maintenance > Print diagnostic image.

NOTE: The report can also be requested from the Embedded Web Server.

It takes about two minutes to print the Print Quality Diagnostic Report.
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Corrective actions
1. If the lines in Test Pattern 1 are not straight and connected, align the printhead (see Align the printhead 

on page 108).

2. If any of the colored blocks in Test Pattern 2 show white lines, or are faded or completely missing, clean 
the printhead (see Clean the printhead on page 107). Follow the front-panel prompts and perform all 
three levels of cleaning if necessary.

3. If the problem remains, clean the printhead again.

4. If the problem remains, replace the ink cartridge (see Replace an ink cartridge on page 103) 
corresponding to the streaked, faded, or missing color block in Test Pattern 2.

5. If the problem remains, replace the printhead (see Replace the printhead on page 108). If the printhead 
is still in warranty, contact HP Support (see Contact HP Support on page 201).

Clean the printhead
If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an 
increasing amount of ink. After each stage, review the quality of the printed page. You should initiate the 
next phase of cleaning only if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

NOTE: Cleaning uses ink, so clean the printhead only when necessary.

NOTE: Failing to turn off the printer correctly can cause print-quality problems.

Clean the printhead from the front panel

1. Make sure there is paper in the input tray or a roll loaded.

2. Go to the front panel, swipe down the dashboard and touch  , then scroll down the menu and touch 
Printer maintenance > Clean printhead.
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Clean the printhead from the Embedded Web Server

1. Make sure there is paper in the input tray or a roll loaded.

2. In the Tools tab of the Embedded Web Server, select Print Quality Toolbox > Clean Printhead, and 
follow the instructions on the screen.

Clean the printhead from the HP Utility

1. Make sure there is paper in the input tray or a roll loaded.

2. Windows: In the Support tab of the HP Utility, select Printhead Cleaning, and follow the instructions on 
the screen.

3. Mac OS X: In the first panel of the HP Utility, select Clean Printheads, and follow the instructions on the 
screen.

Align the printhead
Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in 
graphical elements. Your printer has an automatic printhead alignment process which runs whenever a 
printhead has been accessed or replaced.

You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see Paper handling on page 35. You can use a roll or a cut sheet; plain 
white paper is recommended.

CAUTION: Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the window is closed, as a strong light source near the printer during printhead realignment 
can affect alignment.

3. From the front panel, swipe down the dashboard and touch  , then scroll down the menu and touch 
Printer maintenance > Align printhead.

NOTE: Printhead alignment can also be started from the Embedded Web Server (Tools > Print Quality 
Toolbox > Align Printhead), or from the HP Utility (Windows: Support > Printhead Alignment; Mac OS 
X: Select Align).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

5. The process takes about five minutes. Wait until the front-panel display shows the process complete 
before using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead 
and try again.

Replace the printhead
The image that follows is a QR code containing a link to a video to get more information about how to replace 
a printhead.
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TIP: When the printhead has been replaced, the printer will automatically perform a printhead alignment 
on the loaded paper. If you would like to perform the printhead alignment on a different paper (perhaps from 
the multi-sheet tray), you could change the paper before starting this procedure. Plain white paper is 
recommended.

TIP: Wear cotton gloves to avoid getting your hands dirty.

NOTE: You do not need to use the cartridges provided with the kit. If there is not enough ink, the printer will 
ask for new cartridges and then you can use the supplies provided.

1. Make sure the printer is turned on.

2. Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from 
moving.

3. From the front panel, swipe down the dashboard and touch  , scroll to Printer maintenance and 
select the Replace Printhead option. Follow the instructions on the control panel.

4. When requested on the front panel, open the printhead door on the right hand side of the printer.
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5. Locate the tubes connector lever (blue) to release the ink tubes.

6. Raise the blue lever to release the tube connector and store the tubes connector on the tubes connector 
holder in the printer door.

7. Locate the printhead lever (white).
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8. Raise the lever to release the printhead.

9. Remove the printhead. Handle it with care to avoid getting ink on the connections.

10. Insert the new printhead.

11. Lower the printhead lever (white).

12. Insert the tubes connector into the printhead.
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13. Make sure it locks.

14. Close the door and follow the instructions on the front panel.

15. The front panel recommends a printhead alignment.

The Printer now prepares the printhead for use. The process takes approximately 6 minutes.

IMPORTANT: Do not open any covers during this process.

Recalibrate the paper advance
Accurate paper advance is important to image quality because it is part of controlling the proper placement 
of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark 
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you 
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. 
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the 
rate at which the paper advances. See Troubleshooting print-quality issues on page 141 to determine 
whether paper advance calibration will solve your issue.

Recalibrating the paper advance procedure
1. From the front panel, swipe down the dashboard and touch  , then scroll down the menu and touch 

Printer maintenance > Paper advance calibration > Calibrate paper. The printer automatically 
recalibrates the paper advance and prints a paper advance calibration image which you can send to 
stacker or basket.

2. Wait until the front panel displays the status screen, then re-print your print.

NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper 
advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see 
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return 
to the default calibration, see Return to default calibration on page 113.
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3. If you would like to fine-tune the calibration or are using a transparent paper, swipe down the 
dashboard and touch  , then scroll down the menu and touch Image quality maintenance > Paper 
advance calibration > Adjust paper advance.

4. Select the percentage of change from –99% to +99%. To correct light banding decrease the percentage. 
To correct dark banding increase the percentage.

5. Touch OK on the front panel, to save the value.

6. Wait until the front panel displays the status screen and reprint your print.

Return to default calibration
Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To 
return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, swipe down the dashboard and touch  , then Image Quality Maintenance > 
Paper advance calibration > Reset ready paper calibration.

2. Wait until the front panel displays the operation has completed successfully.

Move or store the printer
Your printer can be disassembled from the stand to move it. Use the blue knob to simply perform this 
operation. If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To 
prepare the printer, follow the instructions below.

1. Do not remove the ink cartridges or printhead.

2. Make sure that no paper is loaded.

3. Turn off the power using the Power key next to the front panel.

4. Unplug the printer's power cord.

5. Disconnect any cables connecting the printer to a network or a computer.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare 
the printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off 
for a six weeks or more, preparing the printhead could take up to 45 minutes.

CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In this 
case, you need to replace the printhead with a new one.

TIP: Because preparing and purging the printhead uses both time and ink, you are strongly recommended 
to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printhead. 
In both cases, the printer wakes up from time to time to maintain the printhead. Thus you can avoid going 
through lengthy preparation processes before using your printer.

Firmware update
The image that follows is a QR code containing a link to a video to get more information about updating your 
firmware.
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There are various ways of downloading and installing firmware updates, as described below; you can choose 
whichever you find most convenient.

NOTE: A firmware update package can be large; you may want to consider whether there are any 
implications for your network or Internet connection.

● You can configure the printer to download firmware updates automatically whenever they become 
available: see Automatic firmware update on page 24.

The following options are available if you choose manual firmware updates.

● Using the front panel, swipe down the dashboard and touch  , then scroll down the menu and touch 
Web Services setup > Product update. Touch Check now to check whether new firmware is available. If 
new firmware is available, you are given the opportunity to download and install it.

● Using the Embedded Web Server, select Firmware Update.

● Using the HP Designjet Utility under Windows, select your printer, the Admin tab and then follow the 
steps in the Firmware Update section.

● Using the HP Utility under Mac OS X, select Update Firmware.

● Using a USB pen drive:

a. download the corresponding file from the web at http://www.hp.com/go/T730/support or 
http://www.hp.com/go/ T830/support accordingly.

b. Copy the file to the root of the USB pen drive.

c. Plug in the USB host and wait until the front panel shows a new icon.

IMPORTANT: This can take about 30 seconds. 

d. Once the new icon named Update Printer appears, touch it and follow the instructions on the front 
panel.
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The firmware includes a set of the most commonly used paper presets.

Software update
Under Windows or Mac OS X, you are normally offered software updates automatically.

For manual updates of printer drivers and other software for your printer, go to http://www.hp.com/go/
T730/drivers or http://www.hp.com/go/T830/drivers.

Printer maintenance kits
Two maintenance kits are available for your printer, containing components that may need to be replaced 
after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 201) and 
request the maintenance kit. The kits are installed by service engineers only.

Clean the scanner scanbars
The image that follows is a QR code containing a link to a video to get more information about how to clean 
and replace a scanbar.

You are recommended to clean the scanbars periodically, depending on how often you use the scanner.

1. Turn off the printer using the Power key close to the front panel, then also turn off the power switch at 
the rear and disconnect the power cable.
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2. There are two small indented buttons at the front of the scanner. Press to open the scanner cover.

WARNING! Be careful while the scanner lid is open. Your fingers or hand may be trapped or crushed.

3. Lift the scanner cover.

4. Clean the scanner scanbars and the surrounding area with a lint-free cloth.

5. For more thorough cleaning, clean the calibration surfaces and the feed rollers.
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6. Close the scanner cover and gently push it down to lock it into place.

7. Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

8. Reconnect the printer's power cable, turn on the power switch at the rear, and turn on the printer using 
the Power key.

Calibrate the scanner
Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be recalibrated 
during their lifetimes. Nevertheless, because of environmental changes, your scanner may start showing 
image defects that can be easily corrected by recalibrating the scanner. The whole procedure takes less than 
10 minutes, and you are recommended to recalibrate the scanner whenever you see some undesired artifact 
or a lack of quality in scanned files or copies, bearing in mind the limitations of CIS technology already 
explained in this guide. If you perform calibration successfully and still have concerns about the image 
quality, please read Troubleshooting copy and scan quality issues on page 155 in order to detect whether 
you are facing a product limitation, and may want to consider buying a CCD scanner.

To calibrate the scanner

1. Clean the scanner. See Clean the scanner scanbars on page 115.

2. Go to the front panel, swipe down the dashboard and touch  , and then scroll down the menu to 
touch Image Quality Maintenance and touch Alignment calibration.

3. Follow the instructions in the front panel.

If calibration fails

1. Ensure that the printer is turned on and ready for normal operation.

2. Ensure that the scanner is working correctly. To test it, scan a small document to file.

3. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the 
calibration process.

4. Eject and reload the calibration sheet, checking that it is clean, in good condition, face up and perfectly 
centered in the scanner.
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5. If the above steps do not help, eject the sheet and restart the printer (turn off and on). When the system 
has restarted, repeat the calibration.

6. If you cannot perform the calibration successfully in three consecutive attempts, call HP support and 
report the error code that appears in the front panel.
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13 Accessories

● How to order supplies and accessories

● Introduction to the accessories
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How to order supplies and accessories
There are two alternative ways to order supplies or accessories for your printer:

● Visit http://www.hp.com/go/T730/accessories or http://www.hp.com/go/T830/accessories on the Web.

● Contact HP Support (see Contact HP Support on page 201).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 13-1  Ink cartridges

Cartridge Part number

HP 728 69 ml Black Ink Cartridge F9J64A

HP 728 40 ml Cyan Ink Cartridge F9J63A

HP 728 40 ml Magenta Ink Cartridge F9J62A

HP 728 40 ml Yellow Ink Cartridge F9J61A

HP 728 300 ml Black Ink Cartridge F9J68A

HP 728 130 ml Cyan Ink Cartridge F9J67A

HP 728 130 ml Magenta Ink Cartridge F9J66A

HP 728 130 ml Yellow Ink Cartridge F9J65A

Table 13-2  Printhead

Printhead Part number

HP 729 Designjet Printhead Replacement Kit F9J81A

Order paper
Your printer can use awide range of paper, check last information related to papers supported b your printer 
at www.hplfmedia.com

Order accessories
The following accessories can be ordered for your printer.

Name Product number

HP USB 3.0 to Gigabit Adapter N7P47AA#AC3

HP DesignJet rugged case N9M07A

HP Designjet 36-in Spindle B3Q37A
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Introduction to the accessories
HP Designjet 36-in Spindle

With extra spindles, you can change rapidly from one paper type to another.

HP USB 3.0 to Gigabit Adapter
The HP USB to Gigabit Adapter connects the USB port to an Ethernet cable for network connection

HP DesignJet rugged case
The HP DesigJet rugged case is a protection designed to sustain hits and dust during transportation and/or 
usage. It increases printer robustness with stronger feet and oversized wheels.
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14 Troubleshooting paper issues

● The paper cannot be loaded successfully

● The paper type is not in the driver

● The printer printed on the wrong paper type

● Paper mismatch

● The roll has jammed

● A single sheet has jammed

● The multi-sheet tray has jammed

● A strip stays on the output tray and generates jams

● The printer displays out of paper when paper is available

● Prints do not fall neatly into the bin

● The sheet stays in the printer when the print has been completed

● The paper is cut when the print has been completed

● The cutter does not cut well

● The roll is loose on the spindle

● Scanner does not load original

● Scanner paper jam removal
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The paper cannot be loaded successfully
● Ensure that no paper is already loaded.

● Ensure that the paper is far enough inside the printer, you should feel the printer grab the paper.

● Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the 
front-panel display. The printer automatically attempts to straighten the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load
● Check that the roll is at least 280 mm (11 in) wide: narrower rolls are not supported.

● Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the 
initial 20 mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.

● Check that the roll ends are tight against the spindle ends.

● Check that the spindle is correctly inserted.

● Check that the output tray is closed. The roll will not load when it is open.

● Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

● Check that all roll end plugs have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, follow the instructions on the front panel.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll 
from the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load
● Check that the sheet is more than 329 mm (12.95 in) wide (A3+). If it is that width or less, load it from 

the multi-sheet tray.

● Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

● Ensure that the sheet is aligned with the reference line on the roll cover.

● Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-
panel display.

● Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the 
sheet from the front of the printer.
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Unsuccessful load from the multi-sheet tray
● Check that you have not loaded too many sheets into the tray. The maximum number of sheets depends 

on the paper thickness: around 50 sheets of plain, standard paper.

● Check that the sheets are correctly loaded into the tray.

● Check that the sheets are correctly adjusted and centered in the tray.

● Check that you have extended the input and output trays correctly: the first extension for A4, the 
second for A3 paper.

If the paper is hanging over the back of the input tray as shown, it may fail to load.

NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, because 
they will deform.

Paper loading error messages
Here is a list of front-panel messages related to paper loading, with the suggested corrective action.
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Front-panel message Suggested action

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much skew. 
Touch OK to unload the roll automatically, then restart the process.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is 
inserted fully and is not transparent.

Paper too far from lateral edge Reload the cut sheet, aligning the right edge against the black stop on the spindle.

Paper load failed. Paper width is smaller 
than the minimum size supported by the 
selected paper source.

Cut sheets smaller than ISO A3 must be loaded using the multi-sheet tray.

Sheet too big During the load process the printer has detected that the sheet of paper is either too 
wide or too long to be loaded correctly.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow or too 
short to be loaded in the printer.

The paper type is not in the driver
To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, 
however, you must identify whether your paper is transparent or translucent, photo or bond, coated or 
technical.

NOTE: For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of ink for 
glossy paper.

Transparent or translucent film
If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear 
film.

If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte 
film.

Photo paper
If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper 
type Photo Gloss Paper. For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type Photo Semi-gloss/
Satin Paper.

To increase gamut on photo paper, select paper type HP Universal Gloss Photo Paper or HP Universal Satin 
Photo Paper, depending on the finish.

Bond and coated or technical paper
Your paper type selection for generic paper depends on the paper’s ink absorption capacity.

● For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing 
Paper > 65 g/m2, depending on the weight of the paper.

● For thin papers (< 90 g/m2) or uncoated papers (for example plain paper or bright white paper), select 
paper type Bond and Coated Paper > Plain Paper. You can also select Recycled Bond Paper.
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● For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > HP Coated Paper.

● For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper > Heavyweight 
Coated Paper.

Black ink is easily removed when touched
This happens when your paper is incompatible with matte black ink. To use an optimized ink combination, 
select paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories 
from thinnest to thickest are:

● Plain Paper

● Coated Paper

● Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 141.

The printer printed on the wrong paper type
If the printer prints your job before you were able to load your desired paper, you may have Any selected for 
the Paper Type in the printer driver. When Any is selected the printer will print immediately on whichever 
paper is loaded. Load your desired paper, see Paper handling on page 35, and select your paper type 
specifically in the driver.

● In the Windows driver dialog: select the Paper/Quality tab, then select your paper type from the Paper 
Type list.

● In the Mac OS X Print dialog: select the Paper/Quality panel, then select your paper type from the 
Paper Type list.

NOTE: Any is the driver default.

Paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits for 
you to decide what to do. There are several ways in which the loaded paper may be considered unsuitable:

● The paper type is not as specified for the job.

● The paper source (roll, multi-sheet tray, or manual feed) is not as specified for the job.

● The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

If the printer stops for a paper mismatch, you can decide among the following alternatives:
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● Load the correct paper and resume printing.

● Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.

● Cancel the job.

The roll has jammed
When a paper jam occurs, you normally see a message about it in the front-panel display.

If your printer is a T830 MFP

1. Open the roll cover.

2. Rewind the roll. You may feel resistance if the paper is stuck; pull firmly.

3. Cut the paper if needed

4. Rewind the roll.
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5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6. Open the front window.

7. Try to move the printhead carriage out of the way.
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8. Carefully remove any of the jammed paper that you can from the front window.

CAUTION: Take care not to damage printer's inside components.

CAUTION: Do not move the paper sideways, as it could damage the printer.

9. Close the front window.
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10. Close the roll cover.

11. Reload the roll, or load a new sheet; see Paper handling on page 35.

If your printer is a T730 Printer

1. Open the roll cover.

2. Open the top window.

3. Remove any of the jammed paper that you can lift up and out from the top of the printer.

4. Cut the paper if needed
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5. Try to move the printhead carriage out of the way.
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6. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

7. Remove any of the jammed paper from the top window.
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8. Close the top window.

9. Load the paper roll again.

10. Close the roll cover.

11. Reload the roll, or load a new sheet; see Paper handling on page 35.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the 
procedure and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see The 
multi-sheet tray has jammed on page 136).
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A single sheet has jammed
When a single sheet jam occurs, you normally see a message about it in the front-panel display.

If your printer is a T830 MFP

1. Remove the single sheet from the printer.

2. Open the front cover.

3. Remove any of the paper jammed.

4. Close the front cover.

If your printer is a T730 Printer

1. Open the top window.
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2. Remove the sheet from the printer.

3. Remove any of the paper jammed.

4. Close the top window when finished.

The multi-sheet tray has jammed
If the paper in the multi-sheet tray has jammed, proceed as follows:

1. Remove as much paper as you can from the multi-sheet tray.

2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.

3. Unlock the tray, using the rotary switch behind it.
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4. Pull out the tray.

5. Remove all paper from the tray.

6. Remove all paper from the printer.

7. Replace the tray.

8. Lock the tray.

A strip stays on the output tray and generates jams
If a small piece of paper has been cut, such as before printing a new roll, or after the front panel option Form 
feed and cut has been used, the cut strip may remain in the output tray. Only when the printer is not printing, 
reach into the tray and remove the strip.
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The printer displays out of paper when paper is available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If 
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the bin
● Ensure the bin is correctly installed.

● Ensure the bin is open.

● Ensure the bin is not full.

● Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or 
remove prints manually as they are completed.

The sheet stays in the printer when the print has been 
completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 44. If 
the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the 
automatic cutter is disabled, use the Form feed and cut option in the front panel, see Form feed with or 
without cutting on page 45.

The paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed, see Change the drying time 
on page 44. You can disable the cutter, see Turn the automatic cutter on and off on page 45.

The cutter does not cut well
By default, the printer is set to cut the paper automatically after the drying time has been completed.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any 
obstacles, and check that there are no pieces of paper in the cutter groove.
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The roll is loose on the spindle
The roll may need to be replaced or reloaded. Check if the roll core is the correct size.

Scanner does not load original
In case you have difficulty loading the original when scanning, please try the following:

1. Check that the unit is on.

2. Wait until the unit has booted up completely and it is idle.

3. Check for messages in the Touch Panel.

4. If you completed the steps above, please check the original meets the scanner specifications.

5. Make sure you are loading the original far enough into the scanner so that it can be detected.

6. Make sure the leading edge of the original is flat and the leading edge is even when loading it. If not, 
trim the leading edge so that the media enters the scanner smoothly.

7. Try using a different media type to exclude that the problem is caused by a scanner hardware issue.

Scanner paper jam removal
When a paper jam occurs, a message normally appears on the front-panel display. To clear a scanner paper 
jam:

1. Open the scanner lid.

2. Pull the paper out from one of the following paths:

● The top rear area at the back

ENWW The roll is loose on the spindle 139



● The front bottom area (between the scanner platen and front window)

CAUTION: Do not move the paper sideways as it could damage the scanner.

● The front bottom area (between the scanner platen and front window)

3. Using your fingers, you can turn the rubber wheels to get better access to the paper and clear any 
debris.

4. Close the scanner lid.
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15 Troubleshooting print-quality issues

● General printing advice

● Horizontal lines across the image (banding)

● Lines are too thick, too thin or missing

● Lines appear stepped or jagged

● Lines print double or in the wrong colors

● Lines are discontinuous

● Lines are blurred

● Line lengths are inaccurate

● The whole image is blurry or grainy

● The paper is not flat

● The print is scuffed or scratched

● Ink marks on the paper

● Black ink comes off when you touch the print

● Edges of objects are stepped or not sharp

● Edges of objects are darker than expected

● Vertical lines of different colors

● White spots on the print

● Colors are inaccurate

● Colors are fading

● The image is incomplete (clipped at the bottom)

● The image is clipped

● Some objects are missing from the printed image

● A PDF file is clipped or objects are missing

● If you still have a problem
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General printing advice
When you have any print-quality problem:

● To achieve the best performance from your printer, use only genuine manufacturer's supplies and 
accessories, whose reliability and performance have been thoroughly tested to give trouble-free 
performance and best-quality prints. For details of recommended papers, see Order paper on page 120.

● Make sure that the paper type selected in the front panel is the same as the paper type loaded into the 
printer (see View information about the paper on page 44). Also make sure that the paper type selected 
in your software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printhead.

● Check that you are using the most appropriate print-quality settings for your purposes (see Printing 
on page 47). You are likely to see lower print quality if you have moved the print-quality slider to the 
'Speed' end of the scale, or set the custom quality level to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range. See 
Environmental specifications on page 207.

Horizontal lines across the image (banding)
If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel 
and in your software. See View information about the paper on page 44.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 47). 
In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality 
level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality.

3. Print the Print Quality Diagnostic Report. See The Print Quality Diagnostic Report on page 106.

4. If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper 
advance on page 112.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.
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Lines are too thick, too thin or missing

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel 
and in your software. See View information about the paper on page 44.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 47). 
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail 
option (if available).

3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line 
quality. You can find the Max. Application Resolution option in the driver dialog's Advanced tab, under 
Document Options > Printer Features.

4. If lines are too thin or missing, print the Print Quality Diagnostic Report. See The Print Quality Diagnostic 
Report on page 106.

5. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance 
on page 112.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.

Lines appear stepped or jagged
If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using 
to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 47.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if 
available).

Lines print double or in the wrong colors
This problem can have various visible symptoms:
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● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if 
recommended in the report. See The Print Quality Diagnostic Report on page 106.

Lines are discontinuous
If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 47.

2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See The 
Print Quality Diagnostic Report on page 106.
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Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. 
See Environmental specifications on page 207.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See 
View information about the paper on page 44.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.

4. Select a lower print quality (such as Speed); the printer will then use less ink.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer 
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated 
Paper, Heavyweight Coated Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See The 
Print Quality Diagnostic Report on page 106.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your 
purposes, you can try to improve line length accuracy in the following ways.

1. Print on HP Heavyweight Coated Paper, for which your printer's line length accuracy is specified. See 
Functional specifications on page 204.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is 
thinner or thicker than HP Heavyweight Coated Paper will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance 
on page 112.
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The whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel 
and in your software. See View information about the paper on page 44.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 47). In some cases, 
you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, 
if you have set the Print Quality slider to Speed, try setting it to Quality.

4. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See The 
Print Quality Diagnostic Report on page 106.

5. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance 
on page 112.

If the problem persists despite all the above actions, contact your customer service representative for 
further support.

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see 
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes 
saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel 
and in your software. See View information about the paper on page 44.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
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3. Select a lower print quality (such as Speed); the printer will then use less ink.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer 
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated 
Paper, Heavyweight Coated Paper.

The print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This 
is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing, 
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Catch your prints as they are cut from the roll and do not let them fall into the bin. Alternatively, leave a 
sheet of paper in the bin so that freshly printed sheets do not make direct contact with the bin.

● Increase the drying time. At the front panel, swipe down the dashboard, touch  , then scroll the menu 
to touch Printer Preferences > Print Retrieval > Select drying time > Extended.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the 
printhead moves over the paper, the printhead may come into contact with the paper and smear the printed 
image. This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Touch  and also cancel the job from 
your computer application. Soaked paper can damage the printhead.

If you notice poor print quality after this has happened, clean the printhead. See Clean the printhead 
on page 107.

Try the following suggestions to avoid this problem:
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel 
and in your software. See View information about the paper on page 44.

2. Use a recommended paper type (see Order paper on page 120) and the correct print settings.

3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect 
performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer 
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated 
Paper, Heavyweight Coated Paper.

6. Try to increase the margins by relocating the image to the center of the page using your software 
application.

Ink marks on the back of the paper
Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte 
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select 
Photo Glossy Paper as the paper type (in the Photo Paper category).

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the 
print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the 
quality level to Speed. See Printing on page 47.
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Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality in 
the driver dialog, select the custom print-quality options, and try setting the quality level to Speed. See 
Printing on page 47.

Vertical lines of different colors
If your print has vertical bands of different colors along it:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated 
Paper. See Order paper on page 120.

2. Try using higher print-quality settings (see Printing on page 47). For instance, if you have set the Print 
Quality slider to Speed, try setting it to Quality.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material. 
To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:
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1. Check that the paper type you have loaded corresponds to the paper type selected.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings. For the most accurate colors, select Normal 
or Best quality.

4. Print the Print Quality Diagnostic Report. See The Print Quality Diagnostic Report on page 106.

Colors are fading
If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more 
than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of 
prints (depending on the type of lamination) with all paper types. For more information, consult your 
laminate provider.

The image is incomplete (clipped at the bottom)
● Did you cancel before all the data were received by the printer? If so, you have ended the data 

transmission and will have to print the page again.

● The I/O timeout setting may be too short. This setting determines how long the printer waits for the 
computer to send more data, before deciding that the job is finished. From the front panel, increase the 
I/O timeout setting to a longer period and then send the print again. Swipe down the dashboard and 
touch  , then scroll down the menu to touch Connectivity > Advanced setup > Select I/O timeout.

● There may be a communications problem between your computer and the printer. Check your USB or 
network cable, or your Wi-Fi connection.

● Check to make sure that your software settings are correct for your current page size (for example, 
long-axis prints).

● If you are using network software, make sure it has not timed out.

The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the 
printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.

printable area = paper size – margins

● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that are 
larger than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own 
minimal margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip 
Contents by Margins option (see Select margins options on page 52).
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● If you are trying to print a very long image on a roll, check that your software is capable of printing an 
image of that size.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide 
enough.

● If necessary, reduce the size of the image or document in your software application, so it fits between 
the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe Photoshop, 
Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot 
handle an image of more than 32,768 pixels.

NOTE: An image 32,768 pixels long would print at a length of 1.39 m (54.61 in) if you select Best or Quality 
in the driver, 2.78 m (109.23 in) if you select Fast, Normal or Speed in the driver.

If you try to print an image larger than this from these applications, the bottom of the image may be clipped. 
To print the whole image, try these suggestions:

● The driver dialog includes an option called Max. application resolution, which enables you to print 
successfully in this situation. You will not normally need to change the default setting, which is Auto. 
However, you can find the option in the Advanced tab, under Document Options > Printer Features.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use a RIP to print the file.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific 
workflows there may be issues that can lead to some objects missing from the output. Here are some 
suggestions to help you to avoid this problem.

● Tell the HP-GL/2 driver to send the image as a bitmap.

● Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use a RIP to print the file.

● Reduce the resolution of bitmap images in your application software.

● Select a lower print quality in order to reduce the resolution of the printed image.

NOTE: If you are working under Mac OS X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality 
or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to 
solve the problem.

A PDF file is clipped or objects are missing
In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects 
when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such problems, 
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upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these 
problems should be solved.

If you still have a problem
If you still experience print-quality problems after applying the advice in this chapter, here are some further 
things that you can do:

● Try using a higher print-quality option. See Printing on page 47.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the 
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be 
downloaded from http://www.hp.com/go/T730/drivers or http://www.hp.com/go/T830/drivers.

● Check that your printer's firmware is up to date. See Firmware update on page 113.

● Check that you have the right settings in your software application.
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16 Troubleshooting scanner issues

Cannot access the network folder
If you have set up a network folder (see Scan to network setup process on page 66), but the printer cannot 
access it, try the following suggestions.

● Check that you have filled in each field correctly.

● Check that the printer is connected to the network.

● Check that the remote computer is switched on, working normally and connected to the network.

● Check that the folder is shared.

● Check that you can put files into the same folder from a different computer on the network, using the 
printer's logon credentials.

● Check that the printer and the remote computer are in the same network subnet; if they are not, check 
that the network routers are configured to forward the CIFS protocol traffic (also known as Samba).

Scanning to file is slow
Scanning large formats creates large files. This means that scanning to file can take time even under optimal 
system configurations and conditions. This is especially true when scanning across a network. However, if 
you think scanning to file with your system is unreasonably slow, the following steps may help you to locate 
and solve the problem.

1. Use the front panel to check the status of your scan job. If it is taking an intolerably long time, you can 
cancel it.

2. Check that the Resolution setting is right for the job. Not all scanning tasks require high resolutions. If 
you lower the resolution, you will speed up the scanning process. For JPEG and PDF scan jobs, you can 
also change the Quality setting. Lower quality values produce smaller files.

3. Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher transfer 
rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet configuration, 
you can expect slower transfer of the scan data and thus slower scanning speeds.

4. Contact your network administrator for information about your network configuration, transfer rates, 
scan-to-file destinations on the network and possible solutions for increasing the speeds.

ENWW Cannot access the network folder 153



5. If scanning to files on the network is too slow and the network configuration cannot be amended to 
correct this, improved speeds can be achieved by scanning to a USB flash drive.

6. If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. Your 
system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with Hi-Speed 
USB (sometimes known as USB 2). Also check that your USB flash drive contains enough storage space 
for scanned large-format images.
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17 Troubleshooting copy and scan quality 
issues

● Random vertical lines

● Wrinkles or folds

● Line discontinuities

● Light colored area fills are missing in the scan or copy

● Grain in area fills when scanning plain paper

● Small color differences between adjacent scanbars

● Vertical light lines at the intersection between scanner scanbars

● Variable line thickness or missing lines

● Inaccurately reproduced colors

● Color fringing

● Clipping in dark or light areas

● Flare in the image when scanning glossy originals

● Vertical red and green bands over white or black background

● Vibration

● Defocus, blurring and fading colors

● Incorrect paper advance, skew during scanning, or horizontal wrinkles

● Vertical black band 30 cm wide

● The scanner damages some originals

● Completely wrong colors

● Vertical distortion

● Object replication (ghosting)

● Clipping or incorrect scale factor when down-scaling in copies and prints

● Incorrect edge detection, mostly when scanning tracing paper
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● A copied or scanned image is very skewed

In this chapter the most common defects and failure modes are shown, sorted by relevance and frequency of 
appearance. A defect is a common image artifact that usually appears when using any CIS scanner. These are 
due to incorrect settings, product limitations, or easily solvable mistakes. A failure mode is due to 
malfunctions of some of the scanner components.

Scanner cleanliness is paramount to ensure good image quality. Before proceeding with any troubleshooting, 
please make sure the glass scanbars are clean and in good condition and the pressure sliders (wide, white 
plastic parts) are also in good and clean condition.

Some of the corrective actions proposed here require the use of the Scanner Diagnostic Plot, which you can 
print and scan as indicated in The scanner diagnostic plot on page 173. When copying, to be sure that the 
defect does not come from the printing function, use this diagnostic plot to detect any scanning issue.Please 
do not use any printed version of this guide to test the scanner, as the resolution of the images included here 
is insufficient. Use the diagnostic plot when recommended in response to any of the errors described in this 
chapter.

Random vertical lines
This is one of the most common issues in sheet-fed scanners. Usually, the vertical streaks are caused by dust 
particles inside the scanner, or miscalibration of the scanner (in these cases, the problem can be solved). 
Here are some examples of images suffering from vertical lines or streaks. Please note the black arrow 
indicating the scanning direction in these examples.

Actions

1. Clean the scanner’s glass scanbars and the original to be scanned as described in Clean the scanner 
scanbars on page 115. Re-boot the printer and re-scan your original afterwards.

2. If the streaks remain, recalibrate the scanner as indicated in Calibrate the scanner on page 117. Re-boot 
the scanner and re-scan your original after the calibration is completed.

3. If the streaks still remain, check the scanner’s glass scanbars and sliders visually. If they are damaged 
(scratched or broken), call HP support.

NOTE: The problem of vertical streaks cannot always be solved, due to the technological limitations of CIS 
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the streaks 
remain after the corrective actions explained above, then no further action can be taken to improve the 
image quality, except to buy a more expensive CCD scanner.

Wrinkles or folds
Scanners based on CIS technology have a high optical resolution within their focus plane, at the price of a 
very limited depth of field. Hence, the images are sharp and detailed when the scanned original is perfectly 
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flat against the glass plate. However, whenever the original contains wrinkles or folds, these defects are 
clearly visible in the scanned image (as shown in the following example).

Actions

1. Re-scan the original and set the background color and noise removal to Off. If copying, set the content 
type to IMAGE.

2. If the problem persists, re-scan the original at a lower scanner resolution (300 dpi or lower resolution if 
scanning, Fast or Normal if copying). It may also help to flatten the original manually as much as 
possible before scanning it again.

NOTE: The problem of wrinkles cannot always be solved, due to the technological limitations of CIS 
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the wrinkles 
remain after the corrective actions explained above, then no further action can be taken to improve the 
image quality, except to buy a more expensive CCD scanner.

Line discontinuities
When scanning or copying large originals, you may sometimes find issues such as that shown in the following 
image, where a straight line (it does not necessarily have to be horizontal) appears with discontinuities or 
small steps. Please note the black arrow indicating the scanning direction in this example.

Actions

1. Repeat the scan, and this time make sure that the product is correctly positioned (it is flat on the floor 
and it does not move). Turning the original 90 or 180 degrees and scanning it again may also solve the 
problem.

2. If the problem persists, check that the original to be scanned is not skewed, and that it does not become 
skewed during the scan. If so, please refer to Incorrect paper advance, skew during scanning, or 
horizontal wrinkles on page 168. You might also want to deactivate the automatic de-skew algorithm 
as indicated in A copied or scanned image is very skewed on page 172.
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3. If there is no skew but the problem persists, clean and calibrate the scanner as indicated in Clean the 
scanner scanbars on page 115 and Calibrate the scanner on page 117. Take care not to move the printer 
during the calibration, and check that the maintenance sheet is correctly positioned before starting the 
calibration. Also check that the maintenance sheet is not damaged before calibrating the scanner (an 
old or damaged maintenance sheet may cause this problem); if it is damaged, reprint it as explained in 
Calibrate the scanner (see Calibrate the scanner on page 117).

4. If the problem persists, proceed to analyze the following areas of the diagnostic plot:

▲ D, H and L (for three modules, 0-Left, 1-Middle, and 2-Right and its intersection)

If you see any of these defects in the studied areas, call HP support and report a “line discontinuities” 
error after calibration.

The four vertical thin black lines at the beginning and the end of the diagnostic plot show, approximately, the 
position of the intersection between scanbars, where this kind of error usually appears. If the error appears 
outside these areas, call HP support and report “line discontinuities within a scanbar”.
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Light colored area fills are missing in the scan or copy
When scanning or copying a map with a light are fill in the top of the plot, the Background color removal 
setting could interpret it as a color in the background and may remove the light areas. The example below 
shows the original image on the left and the scanned image on the right.

Actions

1. Repeat the scan or copy with Background color removal set to Off, or, in the case of copying, you can
select Image as the content type. See Scan settings on page 64 and Copy settings on page 77.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars
on page 115 and Calibrate the scanner on page 117. Repeat it again with Background color removal set
to Off.

Grain in area fills when scanning plain paper
When making copies of an original containing area fills, if the paper used in the printer is plain paper (for 
instance, HP Universal Bond or HP Bright White Inkjet Bond), some grain may appear in the image. This error 
may also appear in scanned files of originals that were printed on textured paper. The example below shows 
the original image on the left and the scanned, grainy image on the right.

Actions

1. Please look at the original and check if it is dirty, has fingerprints on it or if the grain is already present
in the print. If not, then proceed to step 2.

2. If it is a copy, repeat it, setting the content type to Image.

3. If the problem persists:
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● If the problem appears when copying, use Best quality. We also recommend using coated or glossy 
paper in order to avoid grain in copies.

● If the problem appears in a scanned file, scan at a lower resolution (300 dpi or lower resolution).

4. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 115 and Calibrate the scanner on page 117. Check that the maintenance sheet is also clean, and 
that it is not damaged before calibrating the scanner (an old or damaged maintenance sheet may cause 
this problem); if it is damaged, reprint it as explained in Calibrate the scanner (see Calibrate the scanner 
on page 117).

5. If the problem persists, proceed to analyze areas I and J of the diagnostic plot across modules =, 1 and 
3. In the three examples below, the top example is ideal, the middle example can be regarded as 
acceptable; but, if you see something similar to the bottom example (or worse), call HP support and 
report “grain in area fills”.

Small color differences between adjacent scanbars
When scanning wide plots, sometimes slightly different colors can be seen at both sides of the junction 
between two scanbars. This issue, if present, can be easily seen by analyzing patterns A and G of the 
diagnostic plot at the intersection between scanbars. Here are some examples. Please note the black arrow 
indicating the scanning direction in these examples.

160 Chapter 17   Troubleshooting copy and scan quality issues ENWW



Sometimes the color mismatch between adjacent modules can be enormous, showing a serious scanner 
malfunction, as in the following example. If this occurs, see Completely wrong colors on page 169.

Actions

1. Reboot the scanner and repeat the scan or copy. If the problem persists, repeat the scan or copy, setting 
the background color removal to Off or turning the original 90 degrees before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 115 and Calibrate the scanner on page 117. If calibration ended without errors, try to scan or 
copy again.

3. If the problem persists, proceed to analyze patterns A and G in the diagnostic plot, if you see some color 
differences between left and right sides of the bars for neutral and vivid colors, call HP support and 
report “small color differences between adjacent ”. Otherwise, if you see color differences for vivid 
colors but not for neutral colors, see Clipping in dark or light areas on page 164. If necessary, see also 
Grain in area fills when scanning plain paper on page 159.

Vertical light lines at the intersection between scanner scanbars
This problem can be found when scanning large uniform area fills which are made of some light color. You 
sometimes find light vertical bands (around 0.5 cm wide) at the intersection between two scanbars, as in this 
example. Please note the black arrow indicating the scanning direction in this example.

Actions

1. Repeat the scan or copy, rebooting the printer and setting the background color removal to Off or 
turning the original 90 degrees before scanning it again.
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2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 115 and Calibrate the scanner on page 117. Then proceed to analyze pattern number B of the 
diagnostic plot at the intersections between scanbars. The example below shows a good result on the 
left and a bad result on the right: the latter has light vertical banding 0.5 cm wide at the intersection 
between two scanbars.

If you see the kind of result shown on the right, call HP support and report “vertical light bands in area 
fills at the intersection between scanbars, after calibrating the scanner”.

Variable line thickness or missing lines
When scanning some CAD plots at low resolution, mostly when working with grayscale or black-and-white 
prints that contain very thin lines, you may see a variation in line thickness, or even some missing lines, in 
some places:

Actions

1. Repeat the scan or copy using a higher resolution (600 dpi). You should also set Background color 
removal to Off, or, for copying, set the content type to Mixed. You might also deactivate the automatic 
de-skew as explained in A copied or scanned image is very skewed on page 172. In case you were 
working in black-and-white mode, we recommend using grayscale instead.

2. If the problem persists, turn the original plot 90 degrees before scanning it again.

3. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 115 and Calibrate the scanner on page 117.

4. If the problem persists, see Defocus, blurring and fading colors on page 166.

Inaccurately reproduced colors
You have to deal with several variables if you want perfect color matching between the original you are 
scanning and the copy or scanned file you obtain as a result. If you find undesired colors in cases like the 
example shown below (original on the left, scanned image on the right), you can follow these guidelines.
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Actions

1. When dealing with copies, you must take into account that good color matching between a given 
original and its copy can be achieved only if both are printed on the same type of paper. In the case of 
scanned files, good color matching can be achieved only if your monitor is color-calibrated or compliant 
with sRGB or AdobeRGB standards.

2. Reboot the printer and scan or copy again.

3. If the above conditions are met, you should also take into account that various scanner settings can 
affect the final color result, such as Lighter/Darker, background color or noise removal, content type 
and paper type. To obtain the best possible colors, set the Darker/Lighter to Normal, the Background 
color and noise removal to Off, set the Content Type to Image (only if copying), and do not select the 
Translucent Media. See Scan settings on page 64 and Copy settings on page 77.

4. For optimum color results, clean the scanbars (see Clean the scanner scanbars on page 115) and 
calibrate the scanner as indicated in Calibrate the scanner on page 117.

5. Avoid placing the scanner in direct sunlight or near sources of heat or cold.

Color fringing
The problem called “color fringing” occurs when the scanner is affected by incorrect paper advance and/or 
miscalibration. Nevertheless, some amount of color fringing is unavoidable, especially at high scanning 
speeds. It can be seen at the borders of sharp black text over a white background, as in the example below 
(original on the left, scanned image on the right). Please note the black arrow indicating the scanning 
direction.

Actions

1. Repeat the scan after increasing the scanner’s resolution (choose 300dpi or higher quality if scanning, 
Best if copying). Turn your original 90 degrees, if possible, before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Clean the scanner scanbars 
on page 115 and Calibrate the scanner on page 117.

3. If the problem still persists, you can diagnose this issue by analyzing the E patterns of the diagnostic 
plot. The black horizontal lines appear slightly colored at the top and bottom of each end (in the 
example on the right, below). Normally, they look red at the top and blue or green at the bottom, but it 
could be the other way around.

If you see this effect, call HP support and report “color fringing problem after calibration”.
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Clipping in dark or light areas
Sometimes you may see that the scanned file or copy of one of your plots has lost detail in light or dark areas 
(or both), as in the example below: original on the left, scanned image on the right.

Image © www.convincingblack.com, reproduced with permission.

Actions

1. If you are making copies, and the original is printed on photographic paper, while you are copying it 
onto matte paper, this problem is to be expected. However, you can try to reboot the printer and set the 
background color and noise removal to Off and also change the Lighter/Darker settings; this also 
applies if you see this problem in scanned files.

2. If the problem persists, repeat the scan or copy using a higher resolution (300 dpi or higher if scanning, 
Normal or Best if copying). Set the content type to Image (if copying).

3. If the problem persists, recalibrate the scanner as indicated in Calibrate the scanner on page 117. Make 
sure you clean the maintenance sheet before calibrating the scanner, and check that the maintenance 
sheet is not damaged (if so, reprint it as explained in The scanner diagnostic plot on page 173. Re-scan 
your original after the calibration is completed.

4. If the problem persists, analyze patterns M (0, 1 and 2 modules) of the diagnostic plot. If you can 
distinguish lightness steps beyond the upper and lower specified thresholds, then the scanner is fine. 
Here you can see some examples of correct and incorrect functioning.
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If your scanned pattern looks like the incorrect one on the right, whether the clipping is in dark and/or 
light areas, call HP support and report “Clipping in dark/light areas”.

Flare in the image when scanning glossy originals
If the scanner is miscalibrated, or if the original plot you are trying to scan is very glossy or reflective, you can 
sometimes find flare in the scanned image, as in the following example: original on the left, scanned image 
on the right.

Image © www.convincingblack.com, reproduced with permission.

Actions

1. Clean the original and the scanner’s glass plate, then scan again. See Clean the scanner scanbars 
on page 115

2. If the problem persists, recalibrate the scanner as indicated in Calibrate the scanner on page 117. Re-
scan your original after the calibration is completed.

3. If the problem persists, see Clipping in dark or light areas on page 164.

Vertical red and green bands over white or black background
If the scanner has not been calibrated for a long period of time, or if the last calibration failed, you can 
sometimes see defects like the following. Please note the black arrow indicating the scanning direction in this 
example: original on the left, scanned image on the right.

Actions

1. First, reboot the printer and re-scan or copy. Clean and calibrate the scanner as indicated in Clean the 
scanner scanbars on page 115 and Calibrate the scanner on page 117. If the calibration failed, proceed 
as stated in Calibrate the scanner on page 117. However, if the calibration ended correctly, scan your 
original again and check that the colored vertical bands have disappeared.

2. If the problem persists, call HP support and report “vertical red/green bands after calibration”.
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Vibration
If your printer is not properly placed on a flat surface, or if the scanner lid does not close correctly, you may 
sometimes find that the scanned image suffers from vibration, as in the following example: original on the 
left, scanned image on the right.

1. Make sure that the scanner is placed on a flat surface and the scanner lid is correctly closed. Scan your 
original again.

2. If the problem persists, change (increase or decrease) the scanning resolution and re-scan your original. 
We also recommend turning the original 90 degrees before scanning it again.

3. If the problem persists, analyze pattern D of the diagnostic plot. If you see the problem shown on the 
right, call HP support and report a “vibration problem”.

Defocus, blurring and fading colors
CIS technology scanners are tuned to work at a fixed focal distance, and they are very sensitive to small 
variations in the position of the original with respect to the scanner glass plate. If the scanner lid is not 
properly closed, or if the original has deep wrinkles or texture, you may sometimes find problems as in the 
following example (on the right), where the scanned image is blurred and colors are faded.
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Actions

1. Check the scanner lid is properly closed. Open and close the scanner lid by pushing it down until you 
hear a click. Then calibrate the scanner as indicated in Calibrate the scanner on page 117 and reboot and 
repeat your scan.

2. If the problem persists, repeat the scan or copy using a higher resolution (300dpi or more if scanning, 
Normal or Best if copying). You should also set background color removal to Off, or set the content type 
to Mixed, if copying.

3. If the problem persists, analyze pattern F in modules 0, 1 and 2 of the diagnostic plot. A correct example 
is given below, followed by two incorrect examples. Note that there is a black ring near the center of 
pattern F. In this step, you must look at the region near the black ring. If you can see discontinuities in 
the black and white lines, call HP support and report a “defocus or blurring” error.
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Incorrect paper advance, skew during scanning, or horizontal 
wrinkles

You may encounter problems with some thick glossy originals being moved through the scanner’s paper 
path. In some cases, the original may become skewed during the scanning process.

If some of the paper rollers are not working correctly, you may find small horizontal wrinkles in the scanned 
image, due to the paper being stuck in some regions while not in others.

Actions

1. Turn your original 90 degrees and repeat your scan.

2. If the problem persists, open the scanner lid. Clean the feed wheels (small black rubber) and the 
pressure sliders (wide white plastic). If you find dust particles or objects that obstruct the movement of 
the pressure sliders, try to remove them, then close the scanner lid and repeat your scan.

3. If the problem persists, restart the scanner by turning it off and on again. If you find an error message 
on the front panel during this operation, call HP support and report the error message. If no error 
message appears, try repeating your scan.

4. If the problem persists, analyze patterns D, K and L of the diagnostic plot. The plot should look like this:

If you see an image resembling the incorrect examples below, call HP support and report an “incorrect 
paper advance” problem.

Vertical black band 30 cm wide
Your scanner contains various scanner scanbars, each of which covers an area 30 cm (12 in) wide. If one of 
the modules fails, and the scanner hardware check does not detect the failure, you may see a black vertical 
band, corresponding to the area covered by a single scanbar, in your scanned image or copy. Here is an 
example (on the right). Please note the black arrow indicating the scanning direction in this example.

Original Scan affected by a failing scanbar
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Actions

1. Restart the scanner by turning it off and on again. If you find an error message on the front panel during 
this operation, call HP support and report the error message. If no error message appears, try repeating 
your scan.

2. If the problem persists, try to calibrate the scanner as indicated in Calibrate the scanner on page 117. If 
this operation fails, call HP support with the error code given on the front panel. If no error code 
appears, try to repeat your scan.

3. If the problem persists, call HP support and report a “vertical black band 30 cm wide”.

The scanner damages some originals
HP is aware that this scanner may cause vertical scratches on inkjet originals on thick glossy paper. Very thin 
tracing paper or old originals may also be damaged. This is because CIS technology requires the original to be 
held down with high pressure to obtain accurate results and avoid blurring and defocus problems.

If the original you intend to scan is valuable, and if it belongs to one of the types described above (inkjet-
printed, thick, glossy original or old/thin/tracing paper original), HP recommends using a CCD scanner.

Completely wrong colors
If some of the LEDs used for illumination in the scanner scanbars are failing, or the last calibration did not 
work correctly, although no error message was given on the front panel, you may experience some 
completely wrong colors in your scanned images, as in the example below: original on the left, scanned 
image on the right.

1. Restart the scanner by turning it off and on again. If you find an error message on the front panel during 
this operation, call HP support and report the error message.

2. If no error message appears on the front panel during the restart process, try to calibrate your scanner, 
as indicated in Calibrate the scanner on page 117, once it is fully functional. If some error message 
appears on the front panel, call HP support and report the error, adding that you found it after seeing 
“completely wrong colors in the scanned image”.

3. If calibration succeeded, reboot and repeat your scan and check the colors.
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4. If the colors are still wrong, analyze the whole diagnostic sheet. Check that you find completely wrong 
colors in the area corresponding to just one of the scanbars, as in the following figure. If so, call HP 
support and report “completely wrong colors after calibration”, and report the letter of the scanbar that 
is failing (module A in the example).

If all the modules are failing, call HP support and report that.

Vertical distortion
If the lid sensor of the scanner fails, the scanner cannot detect when the lid is open. Hence, you can start a 
scan, and at some point find that the pressure sliders do not move the original through the scanner paper 
path. You may see images like the following when this happens (original on the left, scanned image on the 
right). Please note the black arrow indicating the scanning direction in these examples.

Actions

▲ Open and close the scanner lid by pushing it down until you hear a click. Then repeat your scan and 
visually check that the original advances correctly through the scanner path. If not, call HP support and 
report an “incorrect paper advance” error. Remember that your scanner is not intended to work with 
originals thicker than 0.75 mm (29 mil).

Object replication (ghosting)
This error very rarely appears in CIS scanners. However, you can occasionally find image defects like the 
following: original on the left, scanned image on the right.
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Image © www.convincingblack.com, reproduced with permission.

Actions

1. Restart your printer. Then calibrate the scanner, as indicated in Calibrate the scanner on page 117, and 
repeat your scan. Turn the original 90 degrees if possible before re-scanning. You can also try 
modifying the Lighter/Darker setting.

2. If the problem persists, analyze pattern C, modules 0, 1 and 2, of the diagnostic plot. Call HP support 
and report an “object replication“ issue if you see the kind of error shown on the right.

Clipping or incorrect scale factor when down-scaling in copies 
and prints

When doing copies or prints (from USB, Embedded Web Server, or printer driver), the scaling setting is 
available with various possible options. If you are experiencing problems related to border clipping, or it 
seems that your print has lost the scale-factor adjustment, please read this section carefully in order to 
select the best value for the scaling setting in future jobs.

● Custom (Precise scaling): In this case, the content of the original image is scaled by the percentage 
factor that you have selected. For example, in an original CAD image with a 1:100 scale, if user selects 
scale to 50%, the printed plot will have an accurate scale of 1:200. Nevertheless, in the case of down-
scalings when selecting a fixed percentage, some clipping of the marginal content of the plot may 
occur, as it is impossible for the printer to print up to the borders of the paper.

● Fit to (Scale to fit into page size): In this case, the content of the original image is scaled by the 
percentage necessary to make sure that all the content is correctly printed and no clipping occurs. 
Nevertheless, in the case of down-scalings when selecting fit to page, the scale-factor adjustment may 
not be an integer divisor of the original. For example, in an original CAD plot with a 1:100 scale on A2 
paper size, if user selects scale to fit on A3 paper size, the scaling factor will not be exactly 50% and the 
scale of the printed plot will not be 1:200 exactly. However, the plot will be printed completely without 
clipping any content.
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Incorrect edge detection, mostly when scanning tracing paper
Tracing or translucent papers can be scanned with good results, although totally transparent papers are not 
supported. Nevertheless, the resulting image may have extra margins or some clipping of the content in 
some situations when detection of the edge of the paper is not accurate, which may also happen when 
scanning plain paper if the glass plate is dirty. In order to avoid these undesired effects, please follow these 
recommendations.

Actions

1. Carefully clean the scanner’s glass plate and the original to be scanned with a cloth. Turn the original 90 
degrees if possible and re-scan it afterwards. Remember to select Translucent as the paper type at the 
scanner if your original is translucent.

2. If the problem persists, please calibrate your scanner, and re-scan your original again afterwards.

3. If the problem persists in the case of translucent paper, attach a sheet of white paper to the back of the 
original to be scanned.

A copied or scanned image is very skewed
Originals are often loaded into the scanner with some degree of skew. In order to correct for this unavoidable 
problem, the scanner has a built-in automatic de-skew algorithm, which measures the skew in the original 
and rotates the scanned image so that the result is perfectly straight. However, in some cases the de-skew 
algorithm may increase the skew rather than correcting it. In other cases, the skew is so bad that it cannot be 
automatically corrected.

To load the original with minimum skew, grasp the original with the image facing up and your hands at left 
and right edges. You are recommended to avoid resting your hands or the original on the scanner's input tray. 
Push the original into the scanner insertion slot until you feel the whole top border of the original pressing 
against the scanner rubber rolls, which will load the original after a delay of 0.5 seconds. Now you can take 
your hands off the original. If you are not happy with the way the scanner has grabbed your original, you can 
touch  and try again.

The action of the automatic de-skew algorithm can be deactivated by touching  , then Scan preferences 
or Copy preferences (you might want to deactivate it in one case but not in the other). You can also 
deactivate the automatic de-skew from the Settings button at every new scanner job.

172 Chapter 17   Troubleshooting copy and scan quality issues ENWW



18 The scanner diagnostic plot

● Prepare the printer and the paper to print the diagnostic sheet

● Visual check for errors while printing the diagnostic sheet

● Scan or copy the diagnostic plot

● Monitor calibration

● Save the diagnostic plot for future use
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Prepare the printer and the paper to print the diagnostic sheet
Turn on your printer and wait until it is functioning. Then select the paper on which the diagnostic plot is 
going to be printed (you can reuse the diagnostic plot any time in the future, if it is saved carefully). Ideally, 
the diagnostic plot should be printed on heavyweight paper. Please do not use recycled or tracing paper to 
print this plot. The size of the diagnostic plot is 610 × 914 mm (24 × 36 in). It can be printed on any 914 mm 
(36 in) landscape or 610 mm (24 in) portrait paper roll. You can also use a single sheet that is at least 610 × 
914 mm (24 × 36 in).

You can print the diagnostic plot from the front panel: touch  , then Internal prints > Scanner IQ plot or 
Image Quality Maintenance > Scanner IQ plot > Printer maintenance > Scanner Diagnostic.

Visual check for errors while printing the diagnostic sheet
Once the diagnostic plot is printed, the first step is to check that all the patterns included in it are correctly 
printed. The diagnostic plot, if printed correctly, should look like this:

Some of the most common defects that may appear in a printed diagnostic plot are described below. If you 
find any of these problems, you should follow the recommended recovery procedure. See the 
Troubleshooting print-quality issues on page 141. Once the printer has been diagnosed and it is working 
correctly, you can reprint the diagnostic sheet as described in Prepare the printer and the paper to print the 
diagnostic sheet on page 174.

Resolution
By looking at pattern F you may find problems with the printer’s resolution for the loaded paper. Usually, this 
test does not reveal a printer problem, but a defect in the paper, which may not be suitable for printing the 
diagnostic sheet with the required quality.

Here is what you should see if all is well, followed by two defective examples.
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Alignment
Looking at patterns D, K, and L, you may find problems with the printer’s printhead alignment, which can 
cause defects such as the following.

Additionally, misalignment problems can be seen in patterns D and G in the form of color fringing (which is 
exaggerated below, on the right). That is, the limits between two strong colors are not well defined or a third 
color appears between them.
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Finally, a special pattern for checking the printer’s printhead alignment can be found at the top left of the 
diagnostic sheet. This pattern has no number as it is not used for scanner checking. It is made of three 
colored crosses that may be used to identify the problem in question. The correct pattern is shown on the 
left, an example of misalignment on the right.

Loss of shadow or highlight details
Looking at pattern H, you may find a problem with the printer or the paper. If you can distinguish lightness 
steps beyond the upper and lower specified thresholds, then the printer is fine. Here you can see examples of 
correct functioning on the left, incorrect on the right.

If the printer does not pass this test, you should check that you have correctly selected the paper type and 
the Best quality.

Printer banding
Looking at patterns A, B, and C, you can see vertical banding problems. See the Horizontal lines across the 
image (banding) on page 142.
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Streaks
Looking at patterns A, B, C, G and H, you may find vertical streaks as in the examples shown below, if the 
printer’s printheads are not working correctly. Replacing the printhead for the color showing the streaks may 
solve the problem.

Grain
Looking at patterns A, B, and C, you may find problems in the printer’s paper advance or the printheads that 
cause visible grain in area fills. The following examples show this defect: original on the left, printed image 
on the right.

Scan or copy the diagnostic plot
There are two options for evaluating the diagnostic plot: scanning into a JPEG file, or copying onto paper. We 
recommend using the scan option, so that the generated file can be analyzed more easily by a remote 
support engineer if necessary. If you decide to scan the plot, first adjust your computer’s monitor as 
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described in Monitor calibration on page 178. Once you have scanned the diagnostic plot, please remember 
to open the scanned file in any image viewer software and select a zoom of 100% for correct visual 
evaluation of patterns.

If you decide to copy, make sure that a paper roll at least 36 in (914 mm) wide is loaded in the printer. Ideally, 
the same type of paper used to print the diagnostic plot should be used for copying it.

These are the settings that you should select:

Scan

● Resolution: 600 dpi

● File type: JPG

● Compression: medium

● Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in 
doubt.

Copy

● Content type: Image

Load the diagnostic plot into the scanner input tray, making sure that the printed side of the plot is facing up. 
The black arrows on the diagnostic plot indicate the direction of loading. Make sure that the diagnostic plot is 
loaded without skew, and it is centered (that is, it covers the whole scanner area).

Once you have scanned the diagnostic plot (in case you selected the scan option), please remember to open 
the scanned file in any image viewer software and select a zoom of 100% for correct visual evaluation of 
patterns.

Monitor calibration
The monitor on which the plot is going to be evaluated should ideally be calibrated. As this is not always 
feasible, we propose here to follow an easy procedure for adjusting the brightness and contrast of the 
monitor in order to see the patterns correctly.

Adjust the brightness and contrast of your monitor until you can see a difference in lightness between these 
two squares:

Now you are ready to check each pattern individually.
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Save the diagnostic plot for future use
We recommend saving the diagnostic plot for future use.
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19 Troubleshooting ink cartridge and 
printhead issues

● Cannot insert an ink cartridge

● Ink cartridge status messages

● Cannot insert the printhead

● Cannot connect the tubes to the printhead
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Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number). See Order ink supplies on page 120.

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-
side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
To check the status of ink cartridges, see Check ink cartridge status on page 102

Ink catridge status.

These are the possible ink cartridge status messages:

● OK: The cartridge is working normally, with no known problems.

● Missing or Damaged: There is no cartridge present, or it is not correctly connected to the printer (shown 
with an X on the status screen).

● Low: The ink level is low.

● Out of ink: The cartridge is empty.

● Non-HP ink cartridges installed: The cartridge is not a genuine HP cartridge.

● Incompatible: The cartridge is incompatible with this printer.

Cannot insert the printhead
1. Check that you have the correct type of printhead (model number). See Order ink supplies on page 120 

to check corresponding model number.

2. Check that you have removed the orange protective cap from the printhead.

3. Check that the printhead is correctly oriented.
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4. Check that you have correctly latched the printhead (white latch), see Replace the printhead 
on page 108.

Cannot connect the tubes to the printhead
1. Check that the printhead is correctly inserted. See Cannot insert the printhead on page 182.

2. Check that the tubes connector lever (blue) is up before connecting the tubes connector.
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20 Troubleshooting data communication 
issues

● Communication failures between computer and printer

● Wired network issues

● Wireless network issues

● Mobile printing and web services issues

● The network configuration page
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Communication failures between computer and printer
Some symptoms are:

● The front-panel display does not show the Printing message when you have sent an image to the 
printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your application, see Printing on page 47.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.

● If the printer is connected to a network, check the printer connectivity status: the printer should have an 
IP address and it should match the IP address specified in the printing computer. If the addresses do not 
match, then configure it correctly; if the issue persists, check your network configuration.

● Try another interface cable.

● If the printer is connected to a wireless network, you can request a diagnostic report from the front 
panel: swipe down the dashboard and touch  , then touch Print details . Alternatively, try moving the 
printer closer to the wireless router, or try connecting the printer by wired network.

When a network device automatically configures itself by receiving an IP address from the DHCP service, this 
IP address may change from the last time the device is powered off to the next time it is powered on, which 
may lead to the device being shown as "offline" when driver port settings are configured with the original IP 
address. There are at least three possible ways to avoid this:

● Increase the lease time of your DHCP server device.

● Set a fixed IP address for your printer that will not be changed by DHCP.

● Configure the printer and driver to refer to the hostname instead of the numeric IP address.

To set a fixed IP address for the printer:

1. Go to the front panel, swipe down the dashboard and touch  or .

2. At the bottom of the screen, touch Settings > Advanced setup > IP settings, and enter the IP address, 
the subnet mask, and the gateway (those settings should be provided by your network administrator).

To use the hostname instead of the numeric IP address:

1. Go to the front panel, swipe down the dashboard and take note of the IP address and the hostname 
(HPXXXXXX format).

2. If your computer is running Windows, go to Control Panel > Printers, right-click the printer and select 
Properties > Ports > Configure Port, and in the Printer name or IP address field enter the hostname.
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Wired network issues
If you are unable to install the HP software provided with the printer, check that:

● All cable connections to the computer and the printer are secure.

● The network is operational and the network hub is turned on.

● All applications, including virus protection programs, spyware protection programs, and firewalls, are 
closed or disabled for computers running Windows.

● The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter the IP 
address manually in the installation program. For more information, see The network configuration page 
on page 190.

Though it is not recommended that you assign a static IP address to the printer, you might resolve some 
installation problems (such as a conflict with a personal firewall) by doing so. See Communication failures 
between computer and printer on page 186

Network port created does not match printer IP address (Windows)
If you are using a computer running Windows, make sure that the network ports created in the printer driver 
match the printer's IP address.

1. Print the printer’s network configuration page.

2. Click Start, point to Settings, then click Printers or Printers and Faxes.

– or –

Click Start, click Control Panel, then double-click Printers.

3. Right-click the printer icon, click Properties, and then click the Ports tab.

4. Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the 
network configuration page. If the IP addresses are different, change the IP address in the dialog box to 
match the address on the network configuration page.

6. Click OK twice to save the settings and close the dialog boxes.

Wireless network issues
NOTE: T730 & T830 printers support 2.4 GHz Wireless connection. 5 GHz is not supported

1. Make sure the wireless (802.11) light at the top left of the front panel is turned on  .

If the blue light is not lit, the wireless capabilities may not have been turned on. To turn on wireless, 
swipe down the dashboard, touch  , then Wireless settings > Wireless > On.

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable 
turns off the printer's wireless capabilities.
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3. Restart components of the wireless network.

Turn off the router and the printer, and then turn them back on in this order: router first and then the 
printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, 
turning off the power and then turning it back on can solve a network communication issue.

4. Run the Wireless Network Test.

For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, 
swipe the dashboard and scroll down and touch  , then Settings > Print Wireless Network Test. If a 
problem is detected, the printed test report includes recommendations that could help to solve the 
problem.

Advanced wireless network troubleshooting
If you have tried the above suggestions and are still unable to connect to your printer to the wireless 
network, please try the following:

1. Make sure that your computer's wireless networking has been turned on. For more information, see the 
documentation that came with your computer.

2. If you are not using a unique network name (SSID), then it is possible that your computer could be 
connected to a nearby network that is not yours. The following steps can help you to determine 
whether your computer is connected to your network.

Windows

a. Click Start, click Control Panel, point to Network Connections, then click View Network Status 
and Tasks.

– or –

Click Start, select Settings, click Control Panel, double-click Network Connections, click the View 
menu, then select Details.

Leave the network dialog box open while you continue to the next step.

b. Disconnect the power cord from the wireless router. The connection status of your computer 
should change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status should change to 
Connected.

Mac OS X

▲ Click the Wi-Fi icon in the menu bar at the top of the screen. From the menu that appears, you can 
determine if the AirPort is turned on and which wireless network your computer is connected to.

TIP: For more detailed information about your AirPort connection, click System Preferences in 
the Dock, then click Network. If the wireless connection is working correctly, a green dot appears 
next to AirPort in the list of connections. For more information, click the Help button in the 
window.

If you are unable to get your computer connected to your network, contact the person who set up your 
network or the router manufacturer as there may be a hardware issue with your router or computer.
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If you are able to access the Internet and are using a computer running Windows, you can also access HP 
Network Assistant at http://support.hp.com/us-en/document/c01667669 for help in setting up a 
network (this website is available in English only).

3. Print the printer's Wireless Configuration page (see The network configuration page on page 190). After 
the page has been printed, check the Network Status and URL. The Network Status is Ready if the 
printer is actively connected to a network. The URL is the network address assigned to the printer by 
your router; you need it to connect to the printer's Embedded Web Server.

4. If you have established that the computer and the printer both have active connections to a network, 
you can check whether they are on the same network by trying to access the printer's Embedded Web 
Server (see Access the Embedded Web Server on page 30).

5. If you cannot access the Embedded Web Server and are sure that both the computer and printer have 
active connections to the same network, the firewall security software could be blocking 
communication. Temporarily turn off any firewall security software running on your computer, and try 
to access the Embedded Web Server again. If you can access it, try using the printer for printing.

If you are able to access the Embedded Web Server and use your printer with the firewall turned off, you 
need to reconfigure your firewall settings to allow the computer and printer to communicate with each 
other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with the 
firewall turned off, try enabling the firewall software to recognize the printer.

6. If you have the HP software installed, you can check the printer’s status from your computer to check 
whether the printer is paused or offline, preventing you from using it.

Windows

a. Click Start, point to Settings, then click Printers or Printers and Faxes.

– or –

Click Start, click Control Panel, then double-click Printers.

b. If the printers on your computer are not being displayed in Details view, click the View menu, then 
click Details.

c. Do one of the following, depending on the printer status:

● If the printer is Offline, right-click the printer, and click Use Printer Online.

● If the printer is Paused, right-click the printer, and click Resume Printing.

d. Try using the printer over the network.

Mac OS X

a. Click System Preferences in the Dock, then click Print & Fax.

b. Select the printer, then click Print Queue.

c. If Jobs Stopped appears in the resulting window, click Start Jobs.

7. If you install the HP software a second time, the installer may create a second version of the printer 
driver in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or 
connecting to the printer, make sure the correct version of the printer driver is set as the default.
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a. Click Start, point to Settings, then click Printers or Printers and Faxes.

– or –

Click Start, click Control Panel, then double-click Printers.

b. Right-click the printer icon, and then click Properties, Document Defaults, or Printing 
Preferences.

c. On the Ports tab, look for a port in the list with a checkmark. The version of the printer driver that 
is connected wirelessly has Standard TCP/IP Port as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and 
select Set as Default Printer.

8. Try restarting the HP Network Device Support service (Windows only).

a. Delete any print jobs currently in the print queue.

b. On the desktop, right-click My Computer or Computer, then click Manage.

c. Double-click Services and Applications, then click Services.

d. Scroll down the list of services, right-click HP Network Devices Support, then click Restart.

e. After the service restarts, try using the printer over the network again.

If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your firewall 
may be interfering, or there may be a problem with your network configuration or router. Contact the person 
who set up your network or the router manufacturer for help.

Add hardware addresses to a wireless access point (WAP)
MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called 
“hardware addresses”) of devices that are allowed to gain access to the network through the WAP. If the WAP 
does not have the hardware address of a device attempting to access the network, the WAP denies the device 
access to the network. If the WAP filters MAC addresses, then the printer’s MAC address must be added to the 
WAP’s list of accepted MAC addresses.

1. Print the network configuration page. For more information, see The network configuration page 
on page 190.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted MAC 
addresses.

Mobile printing and web services issues
Please refer to HP Connected: http://www.hpconnected.com for any issues with HP ePrint,

The network configuration page
If the printer is connected to a network, you can print a network configuration page to view the network 
settings for the printer. You can use the network configuration page to help troubleshoot network 
connectivity problems. If you need to call HP, it is often useful to print this page before calling.
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To print the network configuration page from the front panel: swipe down the dashboard and touch  , 
scroll down the menu then Reports > Network Configuration Page.

1. General Information: Shows information about the current status and active connection type of the 
network, and other information, such as the URL of the Embedded Web Server.

2. 802.3 Wired: Shows information about the active wired network connection, such as the IP address, 
subnet mask, default gateway, and hardware address of the printer.

3. 802.11 Wireless: Shows information about your wireless network connection, such as the hostname, IP 
address, subnet mask, default gateway, and server.

4. Miscellaneous: Shows information about more advanced network settings.

● Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP 
port on the printer is the default port for printing. It is accessed by HP software (for example, the 
HP Standard Port).

● LPD: Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer 
spooling services that may be installed on various TCP/IP systems.

NOTE: The LPD functionality can be used with any host implementation of LPD that complies 
with the RFC 1179 document. The process for configuring printer spoolers, however, might differ. 
See your system documentation for information about configuring these systems.

● Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used 
on small networks for IP address and name resolution (through UDP port 5353), where a 
conventional DNS server is not used.

● SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides a 
framework to allow networking applications to discover the existence, location, and configuration 
of networked services in enterprise networks. This protocol simplifies discovery and use of 
network resources such as printers, Web servers, fax machines, video cameras, file systems, 
backup devices (tape drives), databases, directories, mail servers, and calendars.

● Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery (WS 
Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the 
printer. Disable unused print services to prevent access through those services.

NOTE: For more information about WS Discovery and WSD Print, visit 
http://www.microsoft.com/.
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● SNMP: SNMP (Simple Network Management Protocol) is used by network management 
applications for device management. The printer supports SNMPv1 protocol on IP networks.

● WINS: If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the 
printer automatically obtains its IP address from that server and registers its name with any RFC 
1001 and 1002-compliant dynamic name services as long as a WINS server IP address has been 
specified.

5. Connected PC(s): Lists the computers connected to this printer, as well as the last time these 
computers accessed the printer.
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21 Troubleshooting general printer issues

● The printer does not start

● The printer does not print

● The printer seems slow

● The front panel is frozen

● Cannot access the Embedded Web Server

● Alerts
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The printer does not start
If the printer does not start (the front panel is blank), hold down the Power key for a few seconds and check 
whether the Power LED turns orange while the key is held down.

● If you see no orange light, no power is reaching the printer; check that the power cord is correctly 
plugged in. If the problem persists, please call HP Support (see HP Customer Care on page 199) and 
explain that you have a problem with the power supply.

● If you see the orange light, wait for the printer to make a beeping sound.

◦ Three beeps or no beeps means that the front panel is broken; call HP Support and explain.

The printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a 
file you have sent from your computer may not start printing when expected:

● You may have an electrical power problem. If there is no activity at all from the printer, and the front 
panel does not respond, check that the power cord is connected correctly and that there is power 
available at the socket.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or 
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In 
this case, turn off the printer using the Power key close to the front panel and unplug the power cord, 
wait until the electromagnetic environment has returned to normal, then turn it on again. If you still 
experience problems, please contact your customer service representative.

● You may not have installed in your computer the correct driver for your printer, see the Assembly 
instructions.

● If you are printing on a sheet, you must specify Printer Autoselect or Single-Sheet or Multi-Sheet Tray 
as the paper source in your printer driver.

The printer seems slow
Here are some possible explanations.

● Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.

● Did you specify the correct paper type when loading the paper? Some paper types require more time for 
printing; for example, photo and coated papers require more drying time between passes. To find out 
the printer's current paper type setting, see View information about the paper on page 44.

● If your printer is connected by network, check that all components used in the network (network 
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of 
traffic from other devices on the network?

● If your printer is using a wireless network connection, try using a wired network or USB connection.

● Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.
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The front panel is frozen
If the front panel displays a fixed image, reboot the printer, and in case it persists, call HP Support (see HP 
Customer Care on page 199).

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 30.

NOTE: If you connect directly to your printer with a USB cable, you cannot access the Embedded Web 
Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

● In Internet Explorer for Windows, go to Tools > Internet Options > Connections > LAN Settings, and 
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click 
the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy 
server is not used.

● In Safari for Mac OS X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings 
button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy 
server is not used.

If you still cannot connect, switch the printer off and back on with the Power key close to the front panel.

Alerts
Your printer can communicate two types of alerts:

● Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the 
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if 
the printer is able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or 
for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.

● Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a 
warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", 
that reappear when the printer becomes idle and there is not another more severe alert.

● Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer 
status. If there is an alert in the printer, the status shows the alert text.

● Driver: The driver shows alerts. The driver warns about job configuration settings that may produce a 
problem in the final output. If the printer is not ready to print, it displays a warning.

● HP Utility: If the HP Utility is installed, alerts can be automatically displayed under Windows and Mac OS 
X: a new panel opens on your screen with a list of alerts for each printer. This display of alerts can be 
activated under Mac OS X through the HP Printer Monitor, on under Windows by the Alerts Settings in 
the HP Designjet Utility. You can also see the list of active alerts in the Overview tab of the HP Designjet 
Utility for Windows.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as 
displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job 
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from completing, you see a pop-up window, which explains the reason for the problem. Follow the 
instructions to achieve your required result.

NOTE: There are environments that do not support bidirectional communication. In those cases, alerts 
do not reach the job owner.
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22 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please 
follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if 
the recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support 
on page 201.

Table 22-1  Text messages

Message Recommendation

[Color] cartridge is very low on ink Ensure that you have a new cartridge of the same color ready.

Depleted cartridges must be replaced to resume printing Replace the cartridges as needed. See Replace an ink cartridge 
on page 103.

One or more cartridges appear to be missing or damaged Insert cartridges of the correct color as needed. See Replace an 
ink cartridge on page 103.

Paper jam See the User guide or follow the front panel instructions.

Paper width is smaller than the minimum size supported by the 
selected paper source. Load cancelled.

Remove the paper and load paper of the correct size.

Loaded paper is too wide. Manual unload required. Remove the paper manually and load paper of the correct size.

Paper too far from lateral load line. Please try again. Remove and reload the paper.

Please manually unload roll paper and try again. Rewind the roll manually.

Single sheet is loaded with too much skew. Touch Eject to unload 
paper.

Remove and reload the paper.

The current job has been cancelled because the roll is out of 
paper. Load the roll and send the job again.

Load a new roll.

You are printing a multipage job. Load another sheet to continue 
printing or cancel the job.

Load another single sheet.

Multi-sheet tray is out of paper. Load paper in multi-sheet tray 
and touch OK to continue printing or cancel the job.

Load paper into the multi-sheet tray.

End of roll has been reached. It is not possible to load the roll. Load a new roll.

Missing or failed printhead. Remove and reinsert the same printhead, or try cleaning the 
electrical connections. If necessary, insert a new printhead. See 
Replace the printhead on page 108.

NOTE: The error message does not permit returning to the 
home screen to start the printhead replacement. Instead, touch 
Show more.
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Table 22-1  Text messages (continued)

Message Recommendation

Refilled or depleted cartridge detected Check the cartridge.

There is not enough ink in the installed cartridges to complete the 
start-up routine. Replace indicated cartridges.

A new printhead has been inserted without a new set of ink 
cartridges. Replace the cartridges not marked as new. See 
Replace an ink cartridge on page 103.

Wrong file format. The file format is incorrect or not supported. The printer cannot 
process the job, which will be discarded.

Out of memory. The printer cannot complete the job. Resend the job, selecting 
Send job as bitmap in the driver: go to the Advanced tab, then 
Document options > Printer features.

Scanner paper jam Open scanner cover and clear the jam.

Scanner Dust detected Scanner cleaning is recommended.

Scanner Out of memory Scan at a lower resolution and / or Increase compression. See the 
User guide for more information.

Table 22-2  Numerical error codes

Error code Recommendation

0001-0001 Restart the printer.

0081-0008 There may be a paper or carriage jam. Check and clear the paper path if necessary.

0001-0082 The battery of the real-time clock has expired; contact HP Support. See Contact HP Support 
on page 201.

0021-0059, 0021-0017 Service station error. There may be a paper or carriage jam. Check and clear the paper path if 
necessary and restart the printer.

0021-0161 Service station error. Restart the printer.

0041-0017, 0042-0117 There may be a paper or carriage jam. Check and clear the paper path if necessary.

0079-0000 Restart the printer. If the problem persists, update the firmware.

0085-XXXX Feeding paper problem. Restart the printer.

0086-0008 There may be a paper or carriage jam. Check and clear the paper path if necessary. Also clean the 
carriage encoder strip.

0009-XXXX Scanner error. Restart the printer.

For any other error code, restart the printer. If the problem persists contact HP Support.
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23 HP Customer Care

● Introduction

● HP Professional Services

● Customer Self Repair

● Contact HP Support
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Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, 
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end 
support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and 
exchange services, phone and Web support, software updates and self-maintenance services. To find out 
more about HP Customer Care, please visit us at http://www8.hp.com/us/en/large-format-printers/
designjet-printers/support-services.html or call us on the telephone (see Contact HP Support on page 201).

TIP: By taking just a few minutes to register, you can improve your experience with HP and enjoy more 
efficient support. Click http://register.hp.com/ to start. Also click http://www.hp.com/go/alerts to get 
connected with Designjet updates, including product fixes and enhancements.

HP Professional Services
HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your 
HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access to:

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads: the latest printer firmware, drivers, software, etc.

● Technical support: online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software 
applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information: printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/T730/support or http://www.hp.com/go/
T830/support.

By customizing your registration for the products you have purchased and your type of business, and by 
setting your communication preferences, you decide the information you need.

HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard 
period.

They include remote support. On-site service is also provided if necessary, with different arrangements 
available based on the customer needs.

For more information on HP Care Packs, please visit http://www.hp.com/go/carepackcentral.
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Installation Service with Network Setup
The Installation Service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www8.hp.com/us/en/large-
format-printers/designjet-printers/support-services.html.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or 
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. 
Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to address a 
defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact 
HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support
HP Support is available to you by telephone. What to do before you call:

● Review the product functional specifications.

● Review the troubleshooting suggestions in this guide.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call one of the HP offices, please have the following information available to help us answer your 
questions more quickly:

◦ The product you are using (the product number and the serial number, found on the label at the 
back of the product)

◦ If there is an error code on the front panel, note it down; see Front-panel error messages 
on page 197

◦ The computer you are using

◦ Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, 
modems or special software drivers)

◦ The cable you are using (by part number) and where you purchased it

◦ The type of interface used on your product (network, Wi-Fi)
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◦ The software name and version you are currently using

◦ If possible, print out the following reports; you may be asked to fax or mail them to the support 
center helping you: Configuration, Usage Report and “all pages above” from Service Information 
(see Reports on page 15)

Telephone number
Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/
country/us/en/wwcontact_us.html.
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24 Printer specifications

● Functional specifications

● Mobile printing specifications

● Physical specifications

● Memory specifications

● Power specifications

● Ecological specifications

● Environmental specifications

● Acoustic specifications

● Wireless frequency bands
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Functional specifications

Table 24-1  HP 728 ink supplies

HP 729 Printhead One printhead

Ink cartridges Cartridges containing 40 ml of ink: yellow, magenta, and cyan

Cartridges containing 69 ml of ink: black

Cartridges containing 130 ml of ink: yellow, magenta, and cyan

Cartridges containing 300 ml of ink: black

Table 24-2  Paper specifications

Minimum Maximum

Roll width 279 mm (11 in) 914 mm (36 in)

Roll length 46 m (150 feet)

Roll diameter  100 mm (3.9 in)

914 mm (36 in) roll weight  6.2 kg (14 lb)

Sheet width 210 mm (8.27 in) 914 mm (36 in)

Sheet length 279 mm (11 in) 1676 mm (66 in)

Paper thickness  0.3 mm (0.01 in)

Paper weight 60 g/m² 280 g/m² (220 g/m² in multi-sheet tray)

Multi-sheet tray stacking capacity  5 mm height

Table 24-3  Printing resolutions (T730/T830)

Print quality Maximum detail Rendering resolution (ppi) Printing resolution (dpi)

Best (glossy paper*) On

Off

1200 × 1200

600 × 600

2400 × 1200

1200 × 1200

Best (other papers) Off 600 × 600 1200 × 1200

Normal Off 600 × 600 1200 × 1200

Fast Off 600 × 600 1200 × 1200

Econofast Off 600 × 600 1200 × 1200

* For a list of supported glossy papers, see Order paper on page 120.
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Table 24-4  Margins

Top, right and left margins 5 mm (0.2 in)

Bottom margin (trailing edge) 5 mm (0.2 in) (roll and multi-sheet tray)

17 mm (0.67 in) (single sheet)

Table 24-5  Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F),  50-60% relative humidity, on E/A0 printing 
material in Best or Normal mode with HP Heavyweight Coated Paper feed.

Table 24-6  Graphic languages supported

HP Designjet Languages

T730/T830 HP PCL3GUI (Mac OS X), HP-GL/2 and HP RTL (Windows), CALS G4
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Mobile printing specifications

Table 24-7  Mobile printing

Mobile printing Yes, directly from both iOS with AirPrint and Android with HP Print Service Plugin

Mobile devices supported by 
HP Mobile printing

Smartphones and tablets

Supported operating systems iOS, Android, Windows

OS Versions iOS from 7.0 and Android from 4.4, Windows any

Connectivity requirements Printer and mobile device must use the same network

Supported file formats PDF, JPEG

Table 24-8  Email printing

Mobile devices supported Smartphones, tablets, PC

Supported operating systems Any, as long as it has email

Connectivity requirements Cloud connection

Cloud features Remote printing through email

Supported file formats PDF, JPEG, TIFF

Max file size 10 MB

Table 24-9  HP All-in-One Printer Remote app

Printing app HP All-in-One Printer Remote app

Mobile devices supported Smartphones, tablets, PC

Supported operating systems iOS and Android

OS Versions iOS from 7.0 and Android from 4.4

Connectivity requirements Printer and mobile device must use the same network

Supported file formats PDF, JPEG and also can be printed web pages, email attachments, Microsoft Office documents

Physical specifications
Table 24-10  Printer physical specifications

HP Designjet T730 Printer HP Designjet T830 Multifunction Printer

Weight 48 kg (105.82 lb) 62.5 kg (137.79 lb)

Width 1402.5 mm (55.22 in) 1402.5 mm (55.22 in)

206 Chapter 24   Printer specifications ENWW



Table 24-10  Printer physical specifications (continued)

HP Designjet T730 Printer HP Designjet T830 Multifunction Printer

Depth Minimum: 583.28 mm (22.96 in)

Maximum: 896 mm (35.3 in)

Minimum: 629.19 mm (24.77 in)

Maximum: 896 mm (35.3 in)

Height Minimum: 966 mm (38.03 in)

Minimum without stand: 306 mm (12.05 in)

Maximum: 1155 mm (45.47 in) with trays open

Minimum: 966 mm (38.03 in)

Minimum without stand: 306 mm (12.05 in)

Scanner open: 1060 mm (41.73 in)

Maximum: 1155 mm (45.47 in) with trays open

Memory specifications
Table 24-11  Memory specifications

HP Designjet Memory

T730/T830 1 GB

Power specifications
Table 24-12  Printer power specifications

Input Voltage 100–240 V ac ±10%, auto-ranging

Frequency 50/60 Hz

Input Current Max 1200 mA

Typical Power 35 W

Ecological specifications
This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU. To determine 
the ENERGY STAR and EPEAT registration status of your product model please visit http://www.hp.com/go/
ecolabels.

Environmental specifications
Table 24-13  Printer environmental specifications

Operating temperature 5 to 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type

Storage temperature –25 to 55°C (–13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0 to 95% RH
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Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).

Table 24-14  Printer acoustic specifications

Idle sound power level < 3.4 B (A)

Operating sound power level 6.5 B (A)

Idle sound pressure at bystander position < 16 dB (A)

Operating sound pressure at bystander position 48 dB (A)

Wireless frequency bands
Printer is specified to work in the wireless frequency band of: 2.4 GHz (802.11b/g/n)
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Glossary

Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network 
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area 
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a 
limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the 
same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, 
because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling 
of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are 
one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when 
setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the 
device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed 
grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink 
cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted 
area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low 
humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1000,000,000 bits/second. Fast Ethernet interfaces are 
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible 
with original USB. Most personal computers today use Hi-Speed USB.

HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between 
nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually 
unaware whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers 
separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of 
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in 
the world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level 
identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network
A network is a set of connections that pass data between computers and devices. Every device is able to communicate 
with every other device in the same network. This allows data to be moved between computers and devices, and allows 
devices such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, 
dried and pressed.
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Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and 
deposits it on the paper, through a cluster of nozzles.

Spindle
A rod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed 
USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to 
your printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to 
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

Wi-Fi
This term is used for any wireless local area network products that are based on the Institute of Electrical and 
Electronics Engineers' (IEEE) 802.11 standards.
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Email printing 206
email printing 80

enable 13
Embedded Web Server
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HP USB 3.0 to Gigabit Adapter 121
HP Utility

access 30
language 31

I
image problems

clipped at bottom 150
clipped image 150
missing objects 151
PDF problems 151

ink
economical use of 54
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about 102
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memory chip 102
order 120
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line length accuracy 145
line thickness 143
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paper not in driver 126
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too much skew 172
variable line thickness 162
vertical black band 30 cm wide

168
vertical distortion 170
vertical lines between scanbars

161
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diagnostic plot 173
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copy 77
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